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Chapter 1

Introduction

Important Safety Instructions

Safety Requirements

When using your telephone equipment, basic safety precautions should always be followed to 
reduce the risk of fire, electric shock and other personal injury, including the following:

• Please read and understand all instructions.

• Follow all warnings and instructions marked on the product.

• Unplug this product from the wall outlet before cleaning. A damp cloth should be used 
for cleaning; do not use liquid or aerosol cleaners.

• Do not use this product near water, such as in a bathtub, washbowl, kitchen sink, or 
laundry tub, in a wet basement, or near a swimming pool.

• Do not place this product on an unstable card, stand, or table. The product may fall, 
causing serious damage to the product or serious injury.

• Slots and openings in the KSU and the back or bottom are provided for ventilation and to 
protect it from overheating. These openings must not be blocked or covered. The 
openings should never be blocked by placing the product on a bed, sofa, or other similar 
surface. This product should never be placed near or over a radiator or other heat source. 
This product should not be placed in a built-in installation without proper ventilation.

• This product should be operated only from the type of power source indicated on the 
product label. If you are not sure of the type of power supply to your location, consult 
your dealer or local power company.

• Do not allow anything to rest on the power cord. Do not locate this product where the 
cord could be abused by people walking on it.

• Do not overload wall outlets and extension cords as this can result in the risk of fire or 
electric shock.

• Never push objects of any kind into this product through KSU slots or connectors as they 
may touch dangerous voltage points or short out parts that could result in a risk of fire or 
electric shock.
SBX IP 320 Installation Guide
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• Never spill liquid of any kind on the product.

• To reduce the risk of electric shock, do not disassemble this product. Instead, take it to a 
qualified person when service or repair work is required. Opening or removing covers 
may expose you to dangerous voltages or other risk. Incorrect reassemble can cause 
electric shock when the appliance is subsequently used.

• Unplug this product from the wall outlet and refer servicing to qualified service personnel 
under the following conditions: 

• When the power supply cord or plug is damaged or frayed.
• If liquid has been spilled into the product.
• If the product has been exposed to rain or water.
• If the product does not operate normally by following the operating instructions. 

Adjust only those controls that are covered by the operating instructions because 
improper adjustment of other controls may result in damage and will often require 
extensive work by a qualified technician to restore the product to normal 
operation.

• If the product has been dropped or the KSU has been damaged.
• If the product exhibits a distinct change in performance.

• Avoid using a telephone during an electrical storm. There may be a remote risk of electric 
shock from lightning.

• In the event of a gas leak, do not use the telephone near the leak.

Precautions

• Keep the system away from heating appliances and electrical noise generating devices 
such as florescent lamps, motors and televisions. These noise sources can interfere with 
the performance of the SBX IP 320 System.

• This system should be kept free of dust, moisture, high temperature (more than 40 
degrees) and vibration, and should not be exposed to direct sunlight.

• Do not attempt to insert wires, pins, etc. into system. If system does not operate properly, 
the equipment should be repaired by an authorized service center.

• Do not use benzene, paint thinner, or an abrasive powder to clean the KSU. Wipe it with 
a soft cloth only.
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Cautions

• This system should only be installed and serviced by qualified service personnel.

• When a failure occurs which exposes any internal parts, disconnect the power supply 
cord immediately and return this system to your dealer.

• To prevent the risk of fire, electric shock or energy hazard, do not expose this product to 
rain or any type of moisture.

• To protect the PCB from static electricity, discharge body static before touching 
connectors and/or components by touching ground or wearing a ground strap.

Warning:  Danger of explosion if battery is not correctly replaced. Replace only with the same 
or equivalent type recommended by the manufacturer. Dispose of used batteries according to 
the manufacturer’s instructions.

Disposal of Old Appliances

When the displayed symbol (crossed-out wheeled bin) is adhered to a product, it designates the 
product is covered by the European Directive 2002/96/EC.

•All electric and electronic products should be only be disposed 
of in special collection facilities appointed by government or 
local/municipal authorities.

•The correct disposal of your old appliance will help prevent 
potential negative consequences for the environment and 
human health.

•For more detailed information about disposal of your old 
appliances, please contact your city office, waste disposal 
service or the place of product purchase.
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Manual Usage

This document provides general information covering the hardware description and installation 
of the SBX IP 320 System. While every effort has been taken to ensure the accuracy of this 
information Vertical Communications, Inc makes no warranty of accuracy or interpretations 
thereof.

Chapter 2. System Overview

Provides general information on the SBX IP 320 System, including the system specifications 
and capacity.

Chapter 3. KSU Installation

Describes detailed instructions for planning the installation site and procedures to install the 
SBX IP 320 System.

Chapter 4. Board Installation

Describes detailed instructions for installing components of the SBX IP 320 Board.

Chapter 5. Terminal Connections and Wiring Method

Describes the kinds of terminals, maximum distance, and other device connections for the 
terminal.

Chapter 6. Starting the SBX IP 320 System

Provides general information for starting the System and basic Admin programming.

Chapter 7. Database Download/Upload

Describes Database Download and Upload procedures.

Chapter 8. Software Upgrade

Describes Software Upgrade procedures.

Chapter 9. Remote Diagnostics

Describes Remote Diagnostics procedures.

Chapter 10. Troubleshooting

Provides information on the SBX IP 320 System and deals with common troubleshooting 
issues.
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System Overview

SBX IP 320 System Highlights

Features of the SBX IP 320 System include:

• Flexible architecture

• Simplifying system structure

• Powerful PC application via LAN, Modem, RS-232C

• Stable & Enhanced voice features

• Simple installation & efficient system management

• Remote admin & software upgrade through LAN connection

• Remote admin & software upgrade through PSTN modem

• Value-Added features

• Distinctive voice mail (ADPCM 32 Kbps)

• Basic CID (CO & SLT) Function

• 8 Poly internal MOH (13 Music sources)
SBX IP 320 Installation Guide
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System Connection Diagram

The following Figure shows the components that make up the SBX IP 320 System:

SBX IP 320
SBX IP 320 Installation Guide
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System Components

BASIC KSU

EXPANSION KSU

ITEM OPTION 
BOARD DESCRIPTION

KSU Key Service Unit

PSU Power Supply Unit

Main Board MBU Main Board Unit (3 CO, 1 DKT, & 7 Hybrid)

CO & Extension 
Boards

CO Line and DKT/SLT Interface Boards (CHB308 and 
VOIB)

Other Boards VMIU & MODU can be installed

CO Line & 
Extension 
Boards

CHB308 3 CO Lines and 8 Hybrid Interface Board

Other 
Boards

VMIU Voice Mail Interface Unit, 4 channels

MODU MODEM unit (33 Kbps)

ITEM OPTION BOARD DESCRIPTION

KSU Key Service Unit

PSU Power Supply Unit

Main Board EMBU Expansion Main Board Unit (3 CO & 8 Hybrid)

CO & Extension 
Board

CO Line and DKT/SLT Interface Board (CHB308)

Other Boards VMIU, AAFU, MODU, CMU50PR, CMU12PR can be 
installed

CO Line & 
Extension 
Boards

CHB308 3 CO Lines and 8 Hybrid Interface Board
SBX IP 320 Installation Guide



Specifications 2-4
Chapter 2: System Overview
Specifications

ITEM DESCRIPTION SPECIFICATION

CPU ARM7 TDMI core(32bit, 50MHz) 

Switching Device Custom Mixed-Signal ASIC Device

Memory Back-up 
Duration

10 years

PSU AC Voltage Input 100-240 +/- 10% Volt AC @47-63Hz

AC Power Consumption 90W

AC Input Fuse 2A @250Volt AC

DC Output Voltage +5, -5, +27, +30Volt DC

External Back-up Battery Input Voltage +24 Volt DC(+12VDC x 2ea) 

Battery Fuse 5.0A @250Volt AC 

Charging Current Max. 200mA 

Battery Load Current Max. 3A (only BKSU), Max. 6A ( BKSU + 
EKSU) 

Ring Signal 75Vrms, 25Hz

External Relay Contact 1A @ 30Volt DC

Music Source Input 0dBm @ 600ohm

External Paging Port 0dBm @ 600ohm

Ring Detect Sensitivity 30Vrms @ 16-55Hz

DTMF Dialing Frequency Deviation Less than +/-1.8%

Signal Rise Time 5 ms

Tone Duration, on time Min. 50 ms, Normally 100 ms

Inter-digit Time Min. 30 ms, Normally 100 ms 
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Pulse Dialing Pulse Rate 10 PPS

Break/Make Ratio 60/40% or 66/33%

Operating Environment Temperature 0 (oC) – 40 (oC) 

Humidity 0 - 80% (non-condensing)

Dimension KSU 339mm(W) x 288mm(H) x 85mm(D)

Expansion KSU 339mm(W) x 288mm(H) x 85mm(D)

Weight KSU 1.8 Kg

Expansion KSU 1.8 Kg

MODU Analog Modem Bell, ITU-T, V.34 V.32BIS, V.90 

Speed 300bps up to 33Kbps speed rate

Connection Automatic rate negotiation 

VOIB LAN Interface 10 Base-T Ethernet (IEEE 802.3) 

Speed 10 Mbps (Auto-Negotiation) 

Duplex Half Duplex or Full Duplex (Auto-Negotiation)

VOIP Protocol H.323 Revision 2 

Voice Compression G.711/G.726/G729/G.723.1 

Voice/Fax Switching T.38

Echo Cancellation G.165

ITEM DESCRIPTION SPECIFICATION
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DESCRIPTION CAPACITY/BOARD TOTAL

Time Slots 128

CO Line Ports 4/CHB308 12

Max Direct Station (DKT, SLT, DSS) 
Connections

4/CHB308 32

External Relay Contact 2/MBU 2

LAN MBU, VOIB, E1HB8 3

MODEM Channel 1/MODU 1

Attendant Positions 5/System

Intercom Links Non-Blocking

Paging
- All Call
- Internal

1 zone
5 zones

Station Speed Dial 100/station, 24 digits each 500

System Speed Dial 24 digits each 500

Last Number Redial 15-50 (by admin programming 32 digits

CO Line Group 8 8

Station Group 10 10

Conference 3-15 Party All ports are available

Multi-Conference 3-15 Party Max. 3 groups

Internal MOH (13 Music Sources) 1/MBU 1

External MOH 1/MBU 1

External Paging Port 1/MBU 1

External Relay Contact 2/MBU, 2/EMBU 4

Alarm Input 1/MBU 1

RS-232C Port 1/MBU 1

DTMF/CPT Receiver Channels 16 chs/MBU 16 chs

FSK Receiver Channels 16 chs/MBU 16 chs

PFT Circuit 1/MBU, !/EMBU, 1/CHB308 3
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KSU Installation

Pre-Installation

Please read the following guidelines concerning installation and connection before installing the 
SBX IP 320 System. Be sure to comply with applicable local regulations.

Safety Installation Instructions

When installing the telephone wiring, basic safety precautions should always be followed to 
reduce the risk of fire, electric shock and personal injury, including the following:

• Never install the telephone wiring during a lightning story.

• Never install the telephone jack in wet locations unless the jack is specifically designed 
for wet locations.

• Never touch un-insulated telephone wires or terminals unless the telephone line has been 
disconnected at the network interface.

• Use caution when installing or modifying telephone lines.

• Anti-static precautions should be taken during installation.

Installation Precautions

The SBX IP 320 System is designed for wall mounting or a free –standing rack. Avoid installing 
in the following places:

• In direct sunlight and hot, cold, or humid places. Temperature range = 0 to 40oC.

• Places where shocks or vibrations are frequent or strong.

• Dusty places, or places where water or oil may come into contact with the System.

• Near high-frequency generating devices such as sewing machines or electric welders.

• On or near computers, fax machines, or other office equipment, as well as microwave 
ovens or air conditioners.

• Do not obstruct the openings on the top of the SBX IP 320 System.
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• Do not stack up the optional service boards.

Wiring Precautions

Be sure to follow these precautions when wiring:

• Do not wire the telephone cable in parallel with an AC power source, such as a computer, 
fax machine, etc. If the cables are run near those devices, shield the cables with metal 
tubing or use shielded cables and ground the shields.

• If the cables are run on the floor, use protectors to prevent the wires from being stepped 
on. Avoid wiring under carpets.

• Avoid using the same power supply outlet for computers, fax machine, and other office 
equipment to avoid induction noise interruption when using the SBX IP 320 near other 
machines.

• The power and battery switches must be OFF during wiring. After wiring is completed, 
the power switch may be turned ON.

• Incorrect wiring may cause the SBX IP 320 System to operate improperly.  If an 
extension does not operate properly, disconnect the telephone from the extension line and 
then re-connect, or turn the System power OFF and then ON again.

• Use twisted pair cable for connecting CO lines.
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KSU Installation

Unpacking

Open the box and verify the items shown in the following Figure are included: 
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KSU Exterior and Dimension

The following diagram shows the exterior and dimensions of the KSU.
m

m
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Opening and Closing the Front Cover

Opening the Front Cover

1. Open the Cord cover and turn the screws counter-clockwise to loosen as shown in the 
following Figure.

2. Lift the front cover in the direction of the arrow as shown.
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Closing the Front Cover

1. Insert the front cover into the slot on the KSU as shown in the following Figure.

2. Then put the front cover down on the KSU in the direction of the arrow, as shown.

3. Turn the screws clockwise to tighten and close the Cord Cover as shown

Note:  Prior to operation, the front cover of the SBX IP 320 must be closed and the screws 
tightened.
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Power Supply Unit Installation

Before installation, ensure that the AC plug is not connected to an AC outlet. The Power Supply 
Unit (PSU) is pre-installed in the SBX IP 320 KSU and it is located on the left side of the KSU. 
and The PSU provides three DC voltage power sources to the MBU through the 7-pin connector, 
CN7. 

Figure 3-1 PSU Installation (1 of 2)

Place the PSU cover on the PSU as shown in Figure 3-2. Then secure the PSU cover by 
tightening the screws (clockwise turn). 

DESCRIPTION SPECIFICATION

AC Voltage Input 100-240 Vac +/- 10 % 

AC Frequency 47-63 Hz 

AC Power Consumption 90 W

AC Input Fuse 2A @ 250Volt AC 

DC Output Voltage +5V/3A, -5V/0.2A, +27V/0.2A, +30/1.5A

DC Input Voltage +24 Volt DC (+12VDC x 2ea)

Battery Fuse 5.0A @250Volt 

Battery Charging Current 200mA
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Figure 3-2 PSU Installation (2 of 2)

Frame Ground Connection

It is very important that the frame of the SBX IP 320 System is grounded:

1. Turn the grounding screw counter clockwise to loosen, as shown in Figure 3-3.

2. Insert the grounding wire and tighten the screw.

3. Then connect the grounding wire to an appropriate ground source (refer to Caution).

Figure 3-3 Grounding the KSU
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Caution:  

• The equipment should be connected to a socket-outlet with a protective ground 
connection.

• For ground wire, green-and-yellow insulation is required and the cross-sectional area of 
the conductor must be more than UL 1015 AWG#18 (1.0mm)). It is recommended that 
the ground wire is shorter than 1m (3.28ft).

• Proper grounding is very important to protect the SBX IP 320 from external noise or to 
reduce the risk of electrocution in the event of lightning strike.

• Comply with applicable local regulations.

External Backup Battery Installation

In case of power failure, the external backup batteries automatically maintain uninterrupted 
power for the SBX IP 320 System. The external batteries must provide 24V DC; this is generally 
accomplished by connecting two 12V batteries in a series arrangement as shown:

Note:  The cable used to connect the battery is supplied with the KSU. 

Battery operation is controlled by the PSU. The PSU will provide charging current to the 
batteries during normal AC power operation at a maximum of about 200mA. PSU battery 
operation will be halted if the AC power is re-connected or if the battery voltage is too low to 
maintain full-system operation. The external batteries can maintain System operation as needed 
depending on several elements such as battery charge status, condition and capacity of the 
batteries, and System configuration (number of Station ports).
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Caution:  

• It is recommended that you use an external backup battery fuse (5A @ 250V) between 
the battery and the System.

• Recommended battery capacity is 24V/20AH MF; the SBX IP 320 System should be able 
to operate more than 3 hours with batteries that are in good condition.

• Carefully check the battery polarity with cable colors (Red and Blue) when connecting 
the battery to the System.

• Make sure that you do not short out the external batteries and cables.

• There is a danger of explosion if external batteries are incorrectly replaced. Replace only 
with the same or equivalent type recommended by the manufacturer. Dispose of used 
batteries according to the manufacturer’s instructions.

KSU Mounting

Wall Mounting

1. Install 3 anchor plugs in the wall using the mounting template included for accurate 
placement Figure 3-4.

2. Attach the mounting template with the 3 included screws to the 3 anchor plugs.

3. Hook the KSU onto the screws, making sure that the System slides down securely Figure 
3-5.
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Figure 3-4 Mounting Template
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Figure 3-5 Wall Mounting the KSU
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Rack Mounting
To attach the SBX IP 320 System to the rack:
1. Attach the rack bracket to the bottom of the SBX IP 320 System as shown in

Figure 3-6 and attach it to the System securely by tightening the screws clockwise.
2. Affix the bracket with the 4 screws provided as shown.

Figure 3-6 Rack Bracket and Rack Mounting
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Desktop Mounting

To use the SBX IP 320 System on a desk or other flat surface, use the following procedure:

1. To attach the rubber feet to the bottom of the SBX IP 320 System as shown in Figure 3-7, 
first remove the sticker from the rubber feet.

2. After attaching the rubber feet to the BKSU and EKSU, firmly mount the EKSU onto the 
BKSU.

Figure 3-7 Desktop Mounting
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Expansion KSU Installation

Unpacking

Figure 3-8 EKSU Carton Contents
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Connecting Expansion KSU to Basic KSU

To connect, perform the following steps:

1. Remove the dummy of each KSU.

2. Use the link cable to connect the Basic KSU to the Expansion KSU.

3. To secure the link cable, turn the screw clockwise to tighten and then tie the link cable 
with tie cable.

Figure 3-9 Connecting KSUs
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Figure 3-10 EKSU to BKSU Connection

Note:  

• If AC power fails, the last SLT port on the EMBU will be connected to CO1 
automatically.

• Even though the power of EKSU is turned off while both systems(BKSU and EKSU) are 
working properly, the BKSU will restart automatically.
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Expansion KSU Mounting

Note:  Do not make any link cable connections between the BKSU and EKSU until they both 
are properly Wall Mounted or Rack Mounted.

EKSU Wall Mounting

1. Install the EKSU within 5 centimeters of the Basic System.

2. Install 3 anchor plugs in the wall using the mounting template included for accurate 
placement (Figure 3.3.3.1A). The KSU can be mounted either vertically or horizontally.

3. Screw the included 3 screws into the 3 anchor plugs.

Figure 3-11EKSU Mounting Template
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4. Hook the Expansion KSU onto the installed screws, making sure that the system slides 
down securely (Figure 3-12.)

Figure 3-12 EKSU Wall Mounting
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EKSU Rack Mounting

1. It is recommended that you install the Expansion system very close to the Basic System.

2. Attach the rack bracket to the bottom of the SBX IP 320 system as shown in Figure 3-13, 
and securely attach it to the system by tightening the screws clockwise.

Figure 3-13 EKSU Rack Bracket
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3. To attach the SBX IP 320 System to the rack, affix the bracket with the 4 screws provided 
(Figure 3-14).

Figure 3-14 EKSU Rack Mounting
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Board Installation

Installation of the Boards

Prior to installing Boards, the following should be considered: 

Caution:  

• Power must be turned OFF.

• To protect the System from static electricity, do not touch the boards. To discharge static, 
touch a grounded object, or wear a grounding strap.

• Insert boards carefully to avoid bending connector pins (male pins on MBU/EMBU) and 
board damage from power shortage caused by misaligning.

To install the board, perform the following steps: 

• Before inserting the board, remove the dummy slot as shown in #1 of Figure 4-1. 

• Hold the board as shown in #2 of the diagram and carefully insert the board in the 
direction of the arrow so that the board securely engages with the connector (CN2) on the 
main board (#3).

Figure 4-1 Board Installation
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Main Board Unit

The Main Board Unit (MBU) controls communication between the peripheral interfaces, 
supervises all resources in the system, controls the gain adjustment of the PCM signal, generates 
the System tones, and manages System call processing.

Figure 4-2 MBU

Note:  If AC power fails, the last SLT port on  the MBU will be connected to CO1 
automatically.

The MBU is installed in the KSU and it provides various kinds of connectors and RJ11 modular 
jacks for the connection of peripheral boards and miscellaneous functions (refer to Figure and 
Table).
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Figure 4-3 MBU Connection Ports

SWITCH/CONNECTOR FUNCTIONS REMARK

CN1 KSU Connection to EKSU with Link cable 50 pins
CN2 CO and Extension Board (CHB308) Installation 50 pins
CN4 MODU Installation 20 pins
CN5 VMIU 32 pins
CN14 VOIB Installation 16 pins
CN6 JTAG Port for Emulator For Test
CN7 PSU Connection (+5V, -5V, +30V) 7 pins
CN8 RS-232C Port Connection 9 pins
MJ1 3 CO Lines Connection 3 arrays

MJ2
MJ2-1 1 DKT or Alarm Sensor

8 arraysMJ2-2-8 7 DKTs or 7 SLTs Connection
CN13 External Relay Contact 4 pins
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Modular Jack (MJ1 - MJ3) Pin Assignment

MBU MJ1 (CO)

MBU MJ2 (Extension)

MJ3 LAN 1 LAN
PJ1 (Red) External MOH Connection
PJ2 (Blue) External Page Connection

SW1 4 Poles DIP Switch for Software Usage Default = All ON
SW2 Lithium Battery ON/OFF Switch for Memory and 

RTC Backup
Default = OFF

SW3 System Reset Button
SW4 JTAG Reset Enable/Disable Switch Not Assembled

Table 4-1 MBU1 - 1, 2, 3

CONNECTOR PIN NUMBER NO SIGNAL NAME

1, 2 N/A
3, 4 CO-T, CO-R
5, 6 N/A

Table 4-2 MBU MJ2 - 1 (DKT Only)

CONNECTOR PIN NUMBER NO SIGNAL NAME

1 N/A
2 DKT-T

3, 4 Alarm_Detection
5 DKT-R
6 N/A

SWITCH/CONNECTOR FUNCTIONS REMARK
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Note:  When installing DKT or SLT on Hybrid Ports, (MJ2-2,3,4,5,6,7,8), keep the above pin 
assignment. Otherwise the DKT or SLT will not operate normally.

CN13 Pin Assignment (Relay Contact)

Table 4-3 MBU MJ2 - 2, 3, 4, 5, 6, 7, 8

CONNECTOR PIN NUMBER NO SIGNAL NAME

1 N/A
2 DKT-T

3, 4 SLT-T, SLT-R
5 DKT-R
6 N/A

Table 4-4 Terminal DKT

CONNECTOR PIN NUMBER NO SIGNAL NAME

1 N/A
2 RING

3, 4 Reserved
5 TIP
6 N/A

Table 4-5 Terminal SLT

CONNECTOR PIN NUMBER NO SIGNAL NAME

1, 2 N/A
3, 4 TIP, RING
5, 6 N/A

Table 4-6 CN13

CONNECTOR NO SIGNAL NAME

1 Relay 1 - pin 1
2 Relay 1 - pin 2
3 Relay 2 - pin 1
4 Relay 2 - pin 2
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Switch, LED, and Connector

Before programming the System, switch 1-4 should be ON and then power cycle OFF and ON 
to initialize the default System database. Once the database has been initialized, switch 1-4 
should be placed in the OFF position to protect the database.

After putting the SW2 lithium battery switch ON to protect the RAM/RTC data, install the 
option boards to the MBU.

Note:  

• The SW2-DIP switch should be turned ON to protect the System database in case of 
power failure.

• As needed, replace the batteries with the same or equivalent type recommended by the 
manufacturer; the System will not function normally if the battery is incorrectly replaced.

• Dispose of used batteries according to manufacturer instructions and/or local government 
regulations.

• The 4th pole of SW1 should be OFF to protect the features being programmed in Admin 
programming after the System power up and initialization.

Table 4-7 MJ3 Pin Assignment (LAN)

CONNECTOR PIN NUMBER NO SIGNAL NAME FUNCTION

4, 5, 7, 8 RESERVED
1 TX+ Transmit Data
2 TX- Transmit Data
3 RX- Receive Data
6 RX+ Receive Data

Table 4-8 SW1 Functions

SWITCH FUNCTION OFF ON (DEFAULT)

1-1 Administration Programming Access Disable Enable
1-2 Command/Event Trace (Software Testing) Enable Disable
1-3 Simplified Message Desk Interface control 

(SMDI - Voice Mail)
SMDI ON SMDI OFF

1-4 Database Default on Power Up Disable Enable
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Expansion Main Board Unit (EMBU/NTB412)

The Expansion Main Board Unit (EMBU), shown in Figure 4-4, provides the following:

• DKT and SLT Interface Circuits

• Ring Generation circuit

• External Relay contacts for LBC or General purpose

• Peripheral Device Decoding circuit

• Master Clock Generation circuit

• PFT circuit [CO1 ⇔ the last SLT port (STA8)]

• PCM Voice Processing circuit with ACT2 (ASIC, voice switching including DSP) device 
for PCM tone generation and PCM gain control.

Table 4-9 LED Indications

LED MEANING

1-1 Periodic Toggle - ON, 300 msec; OFF, 300 msec
1-2 In Use or Idle Status - ON, One or more Ports in use; OFF, Idle
1-3 Timer - Flashes every 100 msec
1-4 LCD Active Updating - Flashes every 300 msec
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Figure 4-4 EMBU

Note:  

• If AC power fails, the last SLT port on the EMBU will be connected to CO1 
automatically.

• Even though the EKSU power is turned off while both systems (BKSU and EKSU) are 
working properly, the BKSU will restart automatically.
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Figure 4-5 EMBU Connection Ports

Table 4-10 Connector/Modular Jack/Switch Functions

SWITCH/CONNECTOR FUNCTIONS REMARK

CN1 KSU Connection from BKSU with Link cable 50 Pins
CN2 CO and Extention Board (CHB308) installation 50 Pins
CN13 External Relay contact 4 Pins
CN7 PSU connection 7 Pins
MJ1 3 CO connection 3 Arrays
MJ2 8 DKTs or 8 SLTs connection 8 Arrays
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Modular Jack (MJ1 - MJ3) Pin Assignment

EMBU MJ1(CO)

Note:  When installing DKT or SLT on Hybrid Ports, (MJ2 -2,3,4,5,6,7,8), keep the above pin 
assignment. Otherwise the DKT or SLT will not operate normally.

Table 4-11 LED Indications

LED MEANING

LED1 (Blue) Periodic Toggle - ON, 300 msec; OFF, 300 msec

Table 4-12 EMBU1 - 1, 2, 3

CONNECTOR PIN NUMBER NO SIGNAL NAME

1, 2 N/A
3, 4 CO-T, CO-R
5, 6 N/A

Table 4-13 EMBU MJ2 - 1, 2, 3, 4, 5, 6, 7, 8

CONNECTOR PIN NUMBER NO SIGNAL NAME

1 N/A
2 DKT-T

3, 4 SLT-T, SLT-R
5 DKT-R
6 N/A

Table 4-14 Terminal DKT

CONNECTOR PIN NUMBER NO SIGNAL NAME

1 N/A
2 RING

3, 4 Reserved
5 TIP
6 N/A
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CN13 Pin Assignment (Relay Contact)

Installation of the CO Line & Extension Board

CHB308 (3 CO Line and 8 Hybrid Interface Board/NTB417)

The CHB308 can be installed on the CN2 connector of the MBU or EMBU, and provides 3 
CO/PBX Loop Start CO Line interfaces that support Pulse/DTMF signaling. Each interface 
contains ring and loop current circuits, A/D and D/A conversions, and pulse signaling circuitry.

It also provides 8 Hybrid (8 DKTs or 8 SLT interfaces) ports, and can detect FSK signal for 
incoming Caller ID, DTMF signal for incoming caller ID, call progress tone. It also provides 
three on-hook connection paths for CID/SMS.

Table 4-15 Terminal SLT

CONNECTOR PIN NUMBER NO SIGNAL NAME

1, 2 N/A
3, 4 TIP, RING
5, 6 N/A

Table 4-16 CN13

CONNECTOR NO SIGNAL NAME

1 Relay 1 - pin 1
2 Relay 1 - pin 2
3 Relay 2 - pin 1
4 Relay 2 - pin 2

BOARD LINE CONNECTOR 
TYPE DESCRIPTION CABLE

CHB308 3 CO & 8 SLT or 8 DKT RJ11 3 CO Line &
8 Hybrid 
Interface

DKT : 4 wire
CO, SLT : 2 wire
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Figure 4-6 CHB308

Modular Jack (MJ1-MJ2) Pin Assignment

Table 4-17 CHB308 MJ1 - 1, 2, 3

CONNECTOR PIN NUMBER NO SIGNAL NAME

1, 2 N/A
3, 4 CO-T, CO-R
5, 6 N/A

Table 4-18 CHB308 MJ2 - 1, 2, 3, 4, 5, 6, 7, 8

CONNECTOR PIN NUMBER NO SIGNAL NAME

1 N/A
2 DKT-T

3, 4 SLT-T, SLT-R
5 DKT-R
6 N/A
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VOIB (Voice over Internet protocol Board (4ch)/NTB422)

The VOIB can be installed on the MBU and it provides four VoIP channels.

The length of the Ethernet cable should be less than 10 meters.

Figure 4-7 VOIB

The VOIB can be installed on the basic MBU and provides the Ethernet interface for S/W 
applications and VoIP features with optional VoIP daughter board.

The VOIB has the capacity for maximum 4 channels with one(1) VOIB, and VOIU provides 
additional four(4) VoIP channels.

ITEM SPECIFICATION

LAN Interface 10 Base-T Ethernet (IEEE 802.3)
Speed 10 Mbps (Auto-Negotiation)
Duplex Half Duplex or Full Duplex (Auto-Negotiation)
VoIP Protocol H.323 Revision 2
Voice Compression G.711/G.726/G.729/ G.723.1
Voice/Fax Switching T.38
Echo Cancellation G.165
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Various switches and connectors functions

SWITCH/CONNECTOR FUNCTIONS REMARK

SW1 VOIB Reset Switch for CPU 
(S32510A)

SW2 Pole 2: Boot mode selection, others: 
reserved

Default : Pole 2 (ON), Others (OFF)

CN1 JTAG (Joint Test Action Group) for 
debug

CN2 RS-232C Trace Tool Connection
CN3 & CN4 VOIU Board Connection

CN5 MBU Connection
MJ1 Network (RJ-45) Cable Connection

LED SPECIFICATION

LED1 Channel1 seize indication LED (ON:Busy, OFF:Idle)
LED2 Channel2 seize indication LED (ON:Busy, OFF:Idle)
LED3 Channel3 seize indication LED (ON:Busy, OFF:Idle)
LED4 Channel4 seize indication LED (ON:Busy, OFF:Idle)
LED5 Channel5 seize indication LED (ON:Busy, OFF:Idle)
LED6 Channel6 seize indication LED (ON:Busy, OFF:Idle)
LED7 Channel7 seize indication LED (ON:Busy, OFF:Idle)
LED8 Channel8 seize indication LED (ON:Busy, OFF:Idle)
LED9 VOIU DSP operation status LED (ON: Normal, OFF: Fail)

LED10 VOIB DSP operation status LED (ON: Normal, OFF: Fail)
LED11 DSP HINT interrupt LED (ON: Active, OFF: Idle)

MJ1-LD2 (yellow) Speed Status LED (OFF: 10Mbps)
MJ1-LD1 (green/orange) Link Status LED (ON: Link, Toggle: Data Transfer)
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Pin assignment

Note:  10BASE-T runs on Category 3 UTP or higher.

VOIU (Internet protocol unit (4ch)/NTB423)

The VOIU can be installed on the VOIB and it provides four VoIP channels.

Table 4-19 MJ3 Pin Assignment (LAN)

CONNECTOR PIN NUMBER NO SIGNAL NAME FUNCTION

4, 5, 7, 8 RESERVED
1 TX+ Transmit Data
2 TX- Transmit Data
3 RX- Receive Data
6 RX+ Receive Data
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Other Board Installations

Voice Mail Interface Unit (VMIU/NTB420)

The Voice Mail Interface Unit (VMIU) can be installed on CN5 of the MBU, and it provides the 
capability for System announcements, ACD/UCD announcements, and User Greetings.

Note:  User greetings are stored in N and Flash memory and will not be lost by System power 
OFF or reset. MBU SW1-4 and SW2 control the protection of recorded messages.

ITEM DETAIL

Channel 4 Channels
Max Record Time
System Greeting (system announcement)
User Record Time

123 Min.
24 Min.
99 Min.

Max Number of User Voice Messages 800
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Modem Function Unit (MODU/NTB413)

MODU should be installed on the MODU connectors (CN4) of the MBU, and provides an 
analog modem connection. It supports Bell, ITU-T, V.34, V.32BIS, V.90 Protocol at a speed rate 
of 300bps up to 33Kbps, and automatic rate negotiation.
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Terminal Connection And Wiring Method

Terminal and Doorbox Models

MODEL DESCRIPTION

7208D 8-button digital telephone
7224D 24-button digital telephone

-- 48-button DSS Console
-- 2-port digital Doorbox

7208D
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7224D

DSS Doorbox
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Terminal Cabling Distance
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Basic Terminal Connection

DKT and DSS

The following illustrates how to connect the DKT to your System:

SLT

The following illustrates how to connect the SLT to your System:

Table 5-1 DKT and DSS Connection Pin Assignment

CONNECTOR PIN NUMBER NO SIGNAL NAME

1 N/A
2 DKT-T

3, 4 Reserved
5 DKT-R
6 N/A

Table 5-2 SLT Connection Pin Assignment

CONNECTOR PIN NUMBER NO SIGNAL NAME

1, 2 N/A
3, 4 TIP, RING
5, 6 N/A
SBX IP 320 Installation Guide



Basic Terminal Connection 5-5
Chapter 5: Terminal Connection And Wiring Method
Doorbox

Introduction

The Doorbox is an intercom unit that can be installed at the entrance to a building.

By pressing a CALL button, a visitor will be able to communicate with a person inside the 
building who has a keyset with a “call coverage” flexible button associated with the Doorbox.

Installation
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Operating Instructions

The following examples describe how calls will be handled when sent through the Doorbox.

• Call FROM the Doorbox

A visitor can press the CALL button once or the External switch once, depending on the 
setup.

• The visitor will hear music from the Doorbox until the keyset user answers the call.

• The keyset with the call coverage flexible button associated with the Doorbox will 
also ring, and the call coverage button LED will illuminate. Refer to the 
Programming Guide ("Intercom Box Signaling" in STATION ATTRIBUTES).

• The keyset user can answer the call by going off-hook using the handset or by 
pressing the SPEAKER button for speakerphone operation.

• Call TO the Doorbox

The keyset user can go off-hook and press a flexible button that is preprogrammed 
with the Doorbox station number, or dial the number.
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Connecting Additional Terminals

The MBU provides connections for one external music source, one external page port, one relay 
contact, and an alarm detection input monitor through the PJ1 (RED, External MOH) and PJ2 
(BLUE, External Page) audio jack and a MJ3 (RJ11 Modular Jack).

External Music Source Wiring

The MBU accommodates one external music port through a PJ1 (RED) audio jack.

Relay Contacts

The MBU/EMBU provides 2 relay contacts that are used for loud bell or general purpose 
through pin No. 1-4 of CN13.
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External Paging Port Wiring

The MBU supports one external paging port through a PJ2 (BLUE) audio jack.

Alarm Detection Wiring

The MBU provides an external alarm detection input, which can be used to transmit notification 
to extensions when the external switch is closed or opened (programmable through Admin 
Programming). This alarm detection input is provided through MJ2-1 pin 3-4 of the MBU.

Cable Wiring

Wall Mount Wiring

To install wall mount wiring, perform the following steps:

1. Ensure the BKSU and EKSU have been installed correctly.

2. Connect cables to the CO/STA port and the MOH/RS-232C ports as shown in Figure 5-1.

3. Connect the Power cord and the Battery cable.

4. Remove plastic filter pieces.

5. Tie all the cables and the Power cord (if desired) through the tie slot at the bottom-right 
side of the KSUs using the tie cable provided.

6. Close the cover of the KSUs and close the cord cover.
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Figure 5-1 Wall Mount Wiring

Rack Mount Wiring

1. Ensure the BKSU and EKSU have been installed correctly.

2. Connect cables to the CO/STA port and the MOH/RS-232C ports as shown in Figure 5-2.

3. Connect the Power cord and the Battery cable.

4. Remove plastic filter pieces.
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5. Tie all the cables and the Power cord (if desired) through the tie slot at the bottom-right 
side of the KSUs using the tie cable provided.

6. Close the cover of the KSUs and close the cord cover.

Figure 5-2 Rack Mount Wiring
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Starting the SBX IP 320

Before Starting the SBX IP 320

In preparation for programming, perform the following steps:

1. The DIP switch (SW2) should be turned ON prior to installing the MBU to protect the 
System data in case of power failure.

2. Check the DIP switch (SW1) of the MBU to All ON.

3. Plug the AC power cord into the SBX IP 320 System and AC outlet.

4. Program the Nation Code (PGM100) as applicable.

5. Reset the SBX IP 320 System.

6. Set the 4th pole (SW1) of the MBU to OFF when the System operates normally, to 
protect programmed features after System power-up and initialization.

Basic Programming

The SBX IP 320 System can be programmed to meet an individual customer's needs. There are 
two ways to perform Admin Programming:

• PC Admin - Refer to the PC Admin Programming Manual

• DKT - In this manual, DKT (Station 100) Admin Programming is described.

DKT Programming

All programming is done at one station (Station 100, Station Port #00, by default) using the 
7224D Digital Key Telephone.

Additional programming stations may be assigned (113 - FLEX 1), but only one DKT can be 
active in the programming mode at any one time.
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When in programming mode, Station 100 does not operate as a normal telephone, but instead 
works as a programming instrument with all of the buttons redefined. The keys of the dial pad 
are used to enter the various data fields to enter numerical information:

• Flexible Buttons - The 24 buttons located on the right side of the phone are used to 
indicate a specific data field and to enter information.

• 3 Soft Buttons (BACK / DELETE / SAVE) - they are used to go back, to delete data, or to 
save data input.

Button Explanation

The following graphic and its associated table describes the buttons and function keys (refer to 
the IP7208D/IP7024D User Guide for detailed information and operation instructions).

1

2

3

4
5

6
7

8

9

10

11
12

14
13

15
16
17
SBX IP 320 Installation Guide



Basic Programming 6-3
Chapter 6: Starting the SBX IP 320
IP7224D Keyset - Basic Features

1 Handset Used for handset call.

2 Headphone When using a headphone, this button toggles the headphone 
state.

3 Speaker Device used to listen to a caller in a handsfree mode when in 
speaker mode.

4 Speed Used to access speed dialing, save number redial, and last 
number redial. Button is also used to access flexible button 
programming.

5 DND The Do Not Disturb feature lets you activate a “do not ring this 
phone” mode. When DND is active, this button is red.

6 Speaker Button Speaker toggles speakerphone state between speaker mode and 
handset mode. The button is red when speakerphone is active.

7 Hold/Save This button puts a call on hold or saves the PGM.

8 3 Soft Buttons Used to work in conjunction with fixed and flexible features.

9 LCD Display Displays phone status information, dialing directories, and test 
message information.

10 Ring LED Illuminates when the phone is ringing.

11 Trans/PGM This button is used to set up a conference call or transfer a call.

12 Flexible The remaining XX Flex buttons can be assigned a feature.

13 Call back A station can initiate a call back request to another busy station. 
Once that station becomes idle, the station that left the call back 
request is signaled.

14 Volume The volume button adjusts the audio level.

15 MIC Microphone used to speak to a caller in a handsfree mode when in 
speaker mode.

16 Menu Use the menu button to move to the desired option (Dial, MSG, 
Program) and use for arrows key.

17 Phone Book Use this button to save a phone number and to make calls with 
saved information.
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Entering the Programming Mode

To enter programming mode, perform the following Steps:

1. Lift the Handset or press the speaker button on the Admin station. ICM dial tone will 
sound.

2. Press the [TRANS/PGM] button and dial * #. A confirmation tone will sound.

3. Enter the Admin password, if a password has been set; a confirmation tone sounds 
indicating that the Station is in Admin Programming mode.

4. Each program is accessed by pressing the [TRANS/PGM] button The following will 
initially display:

5. Dial the desired three-digit program number. If an error is made while entering data, the 
[TRANS/PGM] button will return to the previous status.

Note:  To return to the previous state while in Admin Programming, press the [BACK] soft 
button (clears the temporary data fields).

Permanent Update Procedure

To accept changes while programming, perform the following steps:

1. Press the [HOLD/SAVE] button when all changes have been entered to store the data 
permanently.

2. A confirmation tone should be heard when pressing the [HOLD/SAVE] button if all data 
was entered correctly. If there were any errors in the entering of data, an error tone will be 
presented and data will not be stored in the permanent memory.

Resetting the System

To reset the System, perform the following:

Enter [PGM] + 450 then [FLEX] +15 and press the [HOLD/SAVE] button.

ENTER PGM NUMBER
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Pre-Programming

Location PGM - Nation Code and Site Name (PGM 100)

Note:  The 4th pole of the DIP switch (SW1) on the MBU must be turned ON.

Nation Code

To program the Nation Code, perform the following steps:

1. Press the [TRANS/PGM] button + PGM number (100) then [FLEX1] + 1 [Nation Code 
for United States].

2. Press the [HOLD/SAVE] button to accept the change.

3. Now Reset the SBX IP 320 to initialize the Database for Nation.

4. Set the 4th pole (SW1) of the MBU OFF when the System operates normally, to protect 
programmed features.

Site Name

1. Press the [TRANS/PGM] button + Enter Site Name (use the following DKT Map, Max. 
23 characters allowed), then press [FLEX 2].

2. Press the [HOLD/SAVE] button to accept the change.

. – 13 
Q – 11 
Z – 12 
1 – 10 

A – 21 
B – 22 
C – 23 
2 – 20 

D – 31 
E – 32 
F – 33 
3 – 30 

G – 41 
H – 42 
I – 43 
4 – 40 

J – 51 
K – 52 
L – 53 
5 – 50 

M – 61 
N – 62 
O – 63 
6 – 60 

P – 71 
Q – 72 
R – 73 
S – 74 
7 – 70 

T – 81 
U – 82 
V – 83 
8 – 80 

W– 91 
X – 92 
Y – 93 
Z – 94 
9 – 90 

Blank – 1 
:  – 2 
,  – 3 

0 – 00  
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NATION CODE TABLE

Nation Code Nation Code Nation Code

Argentina 54 Greece 30 Nigeria 234

Australia 61 Guam 671 Norway 47

Bahrain 973 Guatemala 502 Oman 968

Bangladesh 880 Guyana 592 P.N.G. 675

Belgium 32 Haiti 509 Pakistan 92

Bolivia 591 Honduras 504 Panama 507

Brazil 55 Hong Kong 852 Paraguay 595

Brunei 673 India 91 Peru 51

Burma 95 Indonesia 62 Philippines 63

Cameroon 237 Iran 98 Portugal 351

Canada + USA 1 Iraq 964 Qutar 974

Chile 56 Ireland 353 Saudi Arabia 966

China (Taiwan) 886 Israel 972 Senegal 221

CIS 7 Italy 39 Singapore 65

Columbia 57 Japan 81 South Africa 27

Costa Rica 506 Jordan 962 Spain 34

Cyprus 357 Kenya 254 Sri Lanka 94

Czech 42 Korea 82 Swaziland 268

Denmark 45 Kuwait 965 Sweden 46

Ecuador 593 Liberia 231 Switzerland 41

Egypt 20 Libya 218 Thailand 66

El Salvador 503 Luxembourg 352 Tunisia 216

Ethiopia 251 Malaysia 60 Turkey 90

Fiji 679 Malta 356 U.A.E. 971

Finland 358 Mexico 52 United Kingdom 44

France 33 Monaco 377 United States 1

Gabon 241 Morocco 212 Uruguay 598

Germany 49 Netherlands 31 Venezuela 58

Ghana 233 New Zealand 64 Y.A.R. 967
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Board Assignment (PGM 101)

To use a CO line, an extension line, and a board, ensure that the code of these boards are 
registered on the system at PGM101

When registering a board, if the 4th pole (SW1) of the MBU is on, the board is automatically 
registered. While using the SBX IP 320 System, in case of adding some boards, if passively 
assigning those, you can use them. When the 4th pole (SW1) of the MBU is on and board is 
automatically registered, you must place the 4th pole (SW1) of the MBU off and perform a 
system reset.

While in the Admin programming mode,

1. Press the [TRANS/PGM] button + PGM number (101).

2. Enter slot number (2 digits).

3. Press [FLEX1] button.

4. Enter Board Type code (2 digits).

5. Press the [HOLD/SAVE] button to accept the change.

Table 6-1 Board ID

STA CODE COL CODE ETC CODE

HYBRID 17 VOIB 41 VMIU 64

Table 6-2 Slot Definition

SLOT NUMBER SLOT POSITION KINDS OF BOARDS

01 Hybrid on BKSU HYBRID
02 Optional extension board on BKSU HYBRID
03 Hybrid port on EKSU HYBRID
04 Optional extension board on EKSU HYBRID
05 LCOB on BKSU --
06 Currently not used N/A
07 LCOB on EKSU --
08 Optional LCOB on EKSU --
09 VMIB on BKSU VMIB
10 VOIB on BKSU VOIB
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Figure 6-1 Slot Locations

Logical Slot Assignment (PGM 103)

If assignment of each board is end, it is automatically registered by slot number order. You can 
reassign the slot order of each CO Line or extension line as appropriate to your circumstance.

COL Board

1. Press the [TRANS/PGM] button + PGM number (103) 

2. Press [FLEX1] button.

3. Enter logical slot number (CO board slot: 05, 07, 08, 10)

4. Press [HOLD/SAVE] button to accept change.
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STA Board

1. Press the [TRANS/PGM] button + PGM number (103).

2. Press the [FLEX 2] button.

3. Enter logical slot number (STA board slot: 01-04).

4. Press the [HOLD/SAVE] button to accept change.

VMIU Board

1. Press the [TRANS/PGM] button + PGM number (103).

2. Press the [FLEX 3] button.

3. Enter logical slot number (VMIU Slot: 09).

4. Press the [HOLD/SAVE] button to accept change.

Numbering Plan Type (PGM 104)

To program the Numbering Plan Type, perform the following:

1. Press the [TRANS/PGM] button + 104.

2. Enter the Numbering Plan Type (1 digit, refer to the following Table).

3. Press the [HOLD/SAVE] button to accept changes.

Table 6-3 Slot Definition

NUMBER SET 
TYPE/ PRESS # INTERCOM RANGE DEFAULT REMARK

01 100-147 Yes As the basic type, the 1st digit of the 
Station number should be 1-4

02 100-147 No The Station number can be changed up 
to 799

03 100-147 No
04 700-747 No
05 200-247 No
06 21-68 No
07 100-147 No
08 100-147 No The Station number can be changed up 

to 999
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Flexible Numbering Plan (PGM 105)

To set the Flexible Numbering Plan, perform the following steps:

1. Press the [TRANS/PGM] button + 105.

2. Enter the Station Range (dial the Start and End numbers as described in the Table).

3. Press the [HOLD/SAVE] button to accept changes.

Table 6-4 Numbering Plan Detail

STATION NUMBERS DESCRIPTION

000 001 002 003 [TRANS/PGM] + 105
100 101 102 103
000 001 002 003 Station Number Assign-Four station numbers correspond to the 4 

port numbers. The Station number length is in the range of 2 digits 
through 4 digits. There are two methods for changing the station 
number:
Dial two station numbers - Dial the range of the start and end 
Station numbers. The LCD will show the dialed range value. Press 
the [HOLD/SAVE] button to accept change. All LEDs of BTNs 
will be extinguished.
Press one of FLEX 1-4 - Each FLEX button (1-4) is assigned to a 
corresponding Station number (1- 4) on the current LCD. The LED 
of the pressed Flexible button will show steady light. Dial the new 
Station number and press the [HOLD/SAVE] button to accept 
change, or press another Flexible button to assign a Station number 
to other stations without saving.
To change the next 4 station numbers then press [ ] button. If you 
want to change previous 4 station numbers, then press [ ] button.

To delete all Station numbers, press the [SPEED] button and press 
the [HOLD/SAVE] button; all station numbers will be cleared.

100 101 102 103

000 001 002 003 Press the [HOLD/SAVE] button to save changes to the database 
permanently (Ex: Press FLEX 2, dial 400 and press [HOLD/SAVE] 
button).

100 400 102 103
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Flexible Numbering Plan (PGM 106-107, & 109)

To program Flexible Numbering using PGM 106, perform the following steps:

1. Press the [TRANS/PGM] button + 106.

2. Enter the desired code (refer to the following Table).

3. Press the [HOLD/SAVE] button to accept changes.

Table 6-5 Flexible Numbering Plan (PGM 106)

FLEX ITEM DEFAULT VALUE

1 Station Group Pilot Number Range 620-629
2 Internal Page Zone Number Range 501-510
3 Internal All Call Page 543
4 Meet Me Page 544
5 External Page Zone 545
6 All Call Page (Internal/External) 549
7 SMDR Account Code 550
8 Flash Command to CO Line 551
9 Last Number Redial (LNR) 552

10 Do-Not-Disturb 553
11 Call Forward 554
12 Speed Dial Program 555
13 MSG Wait/Call-Back Enable 556
14 MSG Wait/Call Back Answer 557
15 Speed Dial Access 558
16 Cancel DND/CFW/Pre-Selected MSG Features 559
17 SLT Hold 560
18 Reserved N/A
19 Reserved N/A
20 SLT Program Mode Select 563
21 ACD Reroute 564
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To program Flexible numbering using PGM 107, perform the following Steps:

1. Press the [TRANS/PGM] button + 107.

2. Enter the desired code (refer to the following Table).

3. Press the [HOLD/SAVE] button to accept changes.

Table 6-6 Flexible Numbering Plan (PGM 107)

FLEX ITEM DEFAULT VALUE

1 Alarm Reset 565
2 Group Call Pickup 566
3 UCD Group DND 568
4 Night Answer 569
5 Call Park Location Range 601-610
6 Direct Call Pick-Up 7
7 Access CO Line Group 801-824

(8 + CO Group Line Number)
8 Access Individual CO Line 88 (88 + CO Line Number)
9 Reserved N/A

10 Access Held CO Line Group 8*
11 Access Held Individual CO Line 8# (8# + CO Line Number)
12 Access to CO Line in the 1st Available CO Line Group 9
13 Attendant Call 0
14 Door Open - 1 #*1
15 Door Open - 2 #*2
16 Door Open - 3 #*3
17 Door Open - 4 #*4
18 VM MSG Wait Enable *8
19 VM MSG Wait Cancel *9
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To program Flexible numbering using PGM 109, perform the following steps:

1. Press the [TRANS/PGM] button + 109.

2. Enter the desired code (refer to Table).

3. Press the [HOLD/SAVE] button to accept changes.

Table 6-7 Flexible Numbering Plan (PGM 109)

FLEX ITEM DEFAULT VALUE

1 Reserved N/A
2 Reserved N/A
3 Reserved N/A
4 Conference Room 57
5 SLT Conference Page Join 58
6 Unsupervised Conf Timer Extend ##
7 Reserved N/A
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System IP Setup (PGM 108)

To set up IP functionality, perform the following. Use the # key to skip to the next menu item, 
as needed:

IP Name

1. Press the [TRANS/PGM] button + 108.

2. Press the FLEX 1 Button.

3. Enter the desired IP Name (up to 15 characters).

4. Press the [HOLD/SAVE] button to accept changes.

Server IP Address

1. Press the [TRANS/PGM] button + 108.

2. Press the FLEX 2 Button.

3. Enter the server IP Address (12 digits). (ex., 192168131154 for IP : 192.168.131.154)

4. Press the [HOLD/SAVE] button to accept changes.

Other Codes

1 = 10 6 = 60 Space = 1

2 = 20 7 = 70 , = 3

3 = 30 8 = 80 : = 2

4 = 40 9 = 90 . = 13

5 = 50 0 = 00  = 0
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CLI IP Address

1. Press the [TRANS/PGM] button + 108.

2. Press the FLEX 3 Button.

3. Enter the CLI IP Address (12 digits).

4. Press the [HOLD/SAVE] button to accept changes.

Gateway Address

1. Press the [TRANS/PGM] button + 108.

2. Press the FLEX4 Button.

3. Enter the Gateway Address (12 digits).

4. Press the [HOLD/SAVE] button to accept changes.

Subnet Mask Address

1. Press the [TRANS/PGM] button + 108.

2. Press the FLEX5 Button.

3. Enter the Subnet Mask (12 digits).

4. Press the [HOLD/SAVE] button to accept changes.
SBX IP 320 Installation Guide



Basic Programming 6-16
Chapter 6: Starting the SBX IP 320
SBX IP 320 Installation Guide



Chapter 7

Using Database Upload/Download

General Description

DB Up/Down SBX IP 320 is a PC-based Window S/W to upload/download SBX IP 320 MBU 
Database from/to a PC file. Three connection types are available (TCP, Serial, or Modem). It is 
up to you which connection method to use. These 3 types differ slightly by configuration, 
transfer speed, and transferring protocol. It is strongly recommended that after you upload any 
type of DB, that you reset the SBX IP 320 system.

PC Requirement

• PC OS : Windows 2000 or later

• PC Memory : 128 MB at least

• PC Free Disk Space : 10Mbytes or higher (larger than 20 M Bytes recommended)

• PC Monitor Resolution : VGA or higher

• PC Modem : General analog dial-up modem (only for upgrading through an analog 
phone line)

Connection Method with SBX IP 320

To use the DB Up/Down SBX IP 320 software needed to transfer system data, you will need to 
select one of the following connection methods:

Serial Connection

SBX IP 320 MBU S/W can be updated through RS-232C interface in a PC.

TCP Connection

SBX IP 320 MBU S/W can be updated through LAN interface at the remote PC.
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Modem Connection

SBX IP 320 MBU S/W can be updated through MODEM interface at the remote PC.

SBXIP 320 MPB S/W Version Compatibility

The available SBX IP 320 MPB S/W version is C.7Aa or later. 

Installation

DB Up/Down SBX IP 320 is distributed with PC Admin for SBX IP 320. Refer to the 
installation of PC Admin for SBX IP 320.

Note:  In the setup procedure, if your PC is Windows 95 generic or some system DLL Files 
should be updated , the setup program will request that you restart your PC.

File Component in your Execution Directory

If you use a default installation, the "execution directory" will be located at Program 
Files\Vertical Communications Inc\SBX PCADMIN\Admin

If you install SBX PC Admin successfully and use a default installation, the following files will 
reside in the "execution" directory:

• PC Admin.exe : Main Execution File

• UpLDK.exe : S/W Upgrade Tool

• DBUDLDK.exe : D/B Upload/Download

• LDKDiag.exe : Remote Diagnostics

Choosing Up/Download and Connection Type

To upload the database file in your PC to the SBX IP 320 system, you must choose Upload To 
SBX IP 320. To download the SBX IP 320 MPB’s database from the SBX IP 320 to your PC, 
you must choose Download From SBX IP 320.
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You have to select which system you are connecting to. 

DB Up/Down SBX IP 320 is available through TCP, Modem and Serial connection. Please 
choose the desired connection type. User will see a short dialog showing the requirements for 
the selected connection type. Please check this basic requirements before getting started. 

User Information Dialog

After selecting the desired connection type you have to decide several configuration 
requirements including Admin Password, Database File (*.usr), etc. in the “User Information 
Dialog”. It differs slightly according to the selected connection type.
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Up/Download by Serial Connection 

1. Enter the following entries for Serial connection:

• Serial Port -- Serial port No. in PC connected to SBX IP 320 COM port.

• Baud Rate -- Choose the transferring baud rate (see Note).

• Admin Password -- If SBX IP 320 requires a password to upload/download MBU S/W 
DB.

• Database File -- The database file to be uploaded/downloaded.

• Check Button -- Check this button if you want to reset the SBX IP 320 system after 
uploading DB successfully. It is strongly recommended that after you upload any type of 
DB, that you reset the SBX IP 320 system.

Note:  The transferring baud rate in the PC and the baud rate of COM port in the SBX IP 
320 system must be identical. You can program the SBX IP 320 system baud rate in PGM 
174.

Note:  If you set the PC’s and SBX IP 320 system’s transferring baud rate to 57600 bps, 
it might happen that some keysets display incorrect characters in their LCD, or the SBX 
IP 320 system may be unstable. That rate is the fastest way of upgrading, but 19200bps 
and 9600bps are also available.

2. Press the [Next] button to go to the next step.
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Up/Download by TCP Connection 

1. Enter the following for TCP connection:

• IP Address -- IP address of the destination SBX IP 320 system (see Note).

• Admin Password -- If the SBX IP 320 requires a password to upload/download MBU 
S/W DB.

• Database File -- The database file to be uploaded/downloaded.

• Check Button -- Check this button if you want to reset the SBX IP 320 system after 
uploading DB successfully. It is strongly recommended that after you upload any type of 
DB, that you reset the SBX IP 320 system.

Note:  Assign the SBX IP 320 system IP address before you attempt TCP connection. You can 
program the SBX IP 320 system IP address in PGM 108.

2. Press the [Next] button to go to the next step.
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Up/Download by MODEM Connection

1. If you select a MODEM configuration, the next step is to set the following.

• Dial No. -- Analog telephone number of the destination SBX IP 320 system (see Note).

• Admin Password -- If the SBX IP 320 requires a password to update MBU S/W.

• Range -- The range of DB, which you want to upload/download (such as All DB, LCR 
only, SPD only). 

• Database File -- The database file to be uploaded/downloaded.

• Valid -- It displays the validity of the range of DB, and pushing the “Check” button can 
check the validity. 

• Check Button -- Check this button if you want to reset the SBX IP 320 system after 
uploading DB successfully. It is strongly recommended that after you upload any type of 
DB, that you reset the SBX IP 320 system.

Note:  Assign The Analog telephone number of the SBX IP 320 system to Modem-associated 
device before you attempt MODEM connection. You can program the analog line to 
modem-associated device in PGM 170. 

Note:  The transferring baud rate in the PC and the baud rate of the Modem port (COM Port 3) 
in the SBX IP 320 system must be identical. You can program the SBX IP 320 system baud rate 
in PGM174. Using 9600 bps is recommended. 2400bps is available but slow. 19200bps is also 
available but somewhat unstable.

2. Press the [Next] button to go to the next step.
SBX IP 320 Installation Guide



Starting Database File Upload/Download 7-7
Chapter 7: Using Database Upload/Download
Starting Database File Upload/Download

After setting the detailed configuration for the selected connection type, you are ready to start 
the SBX IP 320 DB Upload/Download. You have the following choices:

Start.:  Database transfer process will start.

Back: Go to the previous step.

Monitor:  Monitor Trace window.

Quit:  Program will be terminated. 

If you press the Start button at this time, all other buttons except the Monitor button will be 
deactivated. In the "Monitor Trace" window, the ongoing progress will be displayed.

Note:  In a MODEM connection, after pressing the Start button, you have to select the details 
for the MODEM interface in the PC. Press OK to get started.
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Transferring Process

When database file transfer is ongoing, you can monitor the process. 
Serial, Modem, and TCP connection use Z-Modem transfer protocol and the sending process 
will be displayed in the Z-Modem window.

Note:  In version3, TCP connection isn't using Z-Modem transfer. So, you can finish the 
process quickly.

Finishing DataBase File Upload/Download

After the S/W transfer process is finished a result dialog will be displayed. If you press the "OK" 
button, you will reveal the dialog below. You can start another upload/download by selecting 
the Yes button.

Note:  It is strongly recommended that after you upload any type of DB, that you reset the SBX 
IP 320 system.
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Software Upgrade

General Description

SBX IP 320 S/W Upgrade is a PC-based Window S/W to update SBX IP 320 MBU S/W by the 
transferred ROM file instead of replacing the whole ROM. Three connection types are available 
(TCP, Serial, or MODEM connection). It is up to the user which connection method to use. 
These 3 types slightly differ by configuration, transfer speed, and transferring protocol.

PC Requirement

• PC OS : Windows 2000 or later

• PC Memory : 128 MB at least

• PC Free Disk Space : 10Mbytes or higher (larger than 20 M Bytes recommended)

• PC Monitor Resolution : VGA or higher

• PC Modem : General analog dial-up modem (only for upgrading through an analog 
phone line)

Connection Method with SBX IP 320

SBX IP 320 S/W Upgrade is available by the following connection methods:

Serial Connection

SBX IP 320 MBU S/W can be updated through RS-232C interface in PC.

TCP Connection

SBX IP 320 MBU S/W can be updated through LAN interface at the remote PC.

Modem Connection

SBX IP 320 MBU S/W can be updated through MODEM interface at the remote PC.
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SBX IP 320 MPB S/W Version Compatibility

The available SBX IP 320 MPB S/W version is C.7Aa or later. 

Installation

Software Upgrade SBX IP 320 is distributed with PC Admin for SBX IP 320. Refer to the 
installation of PC Admin for SBX IP 320.

File Component in your Execution Directory

If you use a default installation, the "execution directory" will be located at Program 
Files\Vertical Communications Inc\SBX PCADMIN\Admin

If you install SBX PC Admin successfully and use a default installation, the following files will 
reside in the "execution" directory:

• PC Admin.exe : Main Execution File

• UpLDK.exe : S/W Upgrade Tool

• DBUDLDK.exe : D/B Upload/Download

• LDKDiag.exe : Remote Diagnostics

Choosing Up/Download and Connection Type 

You have to select which system you are connecting to. 
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SBX IP 320 Upgrade is available through ISDN, TCP, Modem and Serial connection. Choose 
the desired connection type. User will see a short dialog showing the requirements for the 
selected connection type. Check this basic requirements before getting started. 

User Information Dialog

After selecting the desired connection type user has to decide several configuration 
requirements including Admin Password, Binary File etc. in the “User Information Dialog”. It 
slightly differs according to the selected connection type. 

Up/Download by Serial Connection 

Enter the following entries for Serial connection:

• Serial Port -- Serial port No. in PC connected to SBX IP 320 COM port.

• Admin Password -- If the SBX IP 320 requires a password to update MBU S/W.

• Binary File -- The new S/W file data to be updated.
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• Baud Rate -- Choose the transferring baud rate. (see Note) 

Note:  The transferring baud rate in PC and the baud rate of COM port in SBX IP 320 
system must be identical. You can program the SBX IP 320 system baud rate in PGM 174.

Press [Next] button to go to the next step.

Up/Download by TCP Connection 

Enter the following entries for TCP connection:

• IP Address -- IP address of the destination SBX IP 320 system. (see Note) 

• Admin Password -- If the SBX IP 320 requires a password to update MBU S/W.

• Binary File -- The new S/W file data to be updated.

Note:  Assign SBX IP 320 system IP address before you attempt to TCP connection. You can 
program the SBX IP 320 system IP address in PGM 108.

Press [Next] button to go to the next step.
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Upgrade by MODEM Connection

If user selects MODEM configuration the next step is to set the following entries. 

• Dial No. -- Analog telephone number of the destination SBX IP 320 system. (see Note) 

• Admin Password -- If SBX IP 320 requires password to update MBU S/W. 

• Binary File -- The new S/W file data to be updated.

Note:  Assign The Analog telephone number of SBX IP 320 system to Modem associated 
device before you attempt to MODEM connection. You can program set the analog line to 
modem associated device by PGM170.

Note:  The transferring baud rate in PC and the baud rate of Modem port (COM Port 3) in SBX 
IP 320 system must be identical. You can program SBX IP 320 system baud rate in PGM 174. 
Using 9600 bps is recommended (2400bps is available but slow. 19200bps is also available but 
a little unstable).

Note:  It might happen that the MODEM connection will be lost due to the PSTN network 
situation.
Press [Next] button to go to the next step.
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Starting S/W Upgrade

After setting the detailed configuration for the selected connection type, now you are ready to 
start the SBX IP 320 S/W Upgrade. The user has the following choices:

Start.:  S/W transfer process will start.

Back: Go to the previous step.

Monitor:  Monitor Trace window.

Quit: SBX IP 320 S/W Upgrade program will be terminated. 

If you press the Start button at this time all other buttons except the Monitor button will be 
deactivated. In the "Monitor Trace" window the undergoing progress will be displayed.

Note:  In a MODEM connection, after pressing the Start button you have to select the details 
for the MODEM interface in the PC. Press OK to get started.
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Transferring Process

When the S/W file transfer is undergoing you can monitor the process. In an ISDN connection 
you can see the transferring process in the Monitor Dialog window. And hence Serial, Modem, 
and TCP connection is using Z-Modem transfer protocol the sending process will be displayed 
in the Z-Modem window.

Note:  In version3, TCP connection isn't using Z-Modem transfer. So, you can finish the 
process quickly.

Finishing DataBase File Upload/Download 

If the transferring process is finished successfully, "Wait Dialog" will be displayed. That means 
that the SBX IP 320 system has just started software upgrading internally. Every keyset stops 
operating. You must not reset the SBX IP 320 system until it will be automatically reset and run 
again. This will take a few minutes. (You can check whether the upgrading is in proceeding or 
not in SBX IP 320 system's MPB lamp flushing.)

If the S/W transferring process fails, a "Fail Dialog" will be displayed. Check the reason of 
failure in the monitor dialog or trace file that was automatically generated in the PC directory 
where the upgrading software is. You can start another upgrade by selecting the Yes button of 
"Again Dialog".4
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Chapter 9

Remote Diagnostics

The SBX IP 320 Remote Diagnostic Tool is a MS-Windows application program that may be 
used with PC Admin program. This program is for diagnosing problems of the SBX IP 320 
system and also maintaining the system from a remote site. This program can send and receive 
the results of diagnostic commands of the SBX IP 320 system such as GSXD test, Board 
configuration, S/W reset count, Station status, CO status, Station recovery, CO recovery, 
Version display, Help message, and Log out.

Introduction

Hardware/Software Requirements

The system requirements for using this program are as follows:

SBX IP 320

• Serial Port that is installed on MPB as a basic option.

• LAN Port should be installed on MPB for LAN connection.

• Unique IP Address should be assigned for LAN connection.

• MODU that is installed on MPB.

PC

• Pentium Celeron 233MHz CPU or higher CPU

• 256 color Super VGA (800 x 600) or higher

• One or more Serial Port

• NIC (Network Interface Card) for LAN Connection.

• 2 button Mouse

• At least 32MB RAM 

• MS-Windows 95/98/2000/me/XP/NT

• Enough hard drive space for installation
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Cable

• RS-232C Type Cable for connecting the PC and theSBX IP 320 system: Two connectors 
are needed for this connection. One connector should be a 9-pin female connector that is 
to be connected to the SBX IP 320, and the other one should fit the serial port of the PC. 
There are three required lines that must be connected for the communication between the 
PC and the SBX IP 320 system: Ground-Ground, Transmit-Transmit, and 
Receive-Receive.

• If external modem is used for PC, serial cable is need for the connection between PC and 
modem. About the connection between PC and modem, user must refer to the user's 
manual of the modem and follow the description.

• If NIC is used for LAN connection, UTP cable will be needed with RJ-45 Jack between 
the PC and the SBX IP 320 system.

Hardware Configuration

To use a serial connection between the PC and the SBX IP 320 system, the PC must be 
connected to the basic serial port of the SBX IP 320 system.

To use a modem connection between the PC and the SBX IP 320 system, a MODU must be 
installed in the SBX IP 320 system and a modem must be installed in the PC.

To use a LAN connection between PC and the SBX IP 320 system, the PC and the SBX IP 320 
system must be connected to the local network.

Installing Software

Once the hardware is installed, you are ready to install the software.

Microsoft Windows must be installed on your computer before you install [SBX IP 320 Remote 
Diagnostic Tool] program. For information on installing Windows, refer to appropriate user's 
manual. 

Remote diagnostic software is a part of the PC Admin software package. So, you must install 
the PC admin software package to use remote diagnostic software.

Uninstalling Software

To uninstall the [SBX IP 320 Remote Diagnostic Tool] program, you may use [Control panel' 
Add/Remove Program] in Windows. If you uninstall the SBX IP 320 PC Admin Package, the 
SBX IP 320 remote diagnostic software will also be uninstalled.
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Important Notes for Users

• [SBX IP 320 Remote Diagnostic Tool] is installed with the PC Admin program.

• To use a modem connection with this program, TAPI and TAPI32 Dynamic-Link Library 
and TAPISRV.EXE must be installed in MS-Windows. These files are installed in most of 
the PCs in which MS-Windows is installed.

• When you uninstall [SBX IP 320 Remote Diagnostic Tool], some files may not be 
deleted if the files were create after the installation of this program. Those files can be 
[PhoneNo.txt] file that is created after the [Save] button is clicked on [Phone Number 
Dialog], or other saved files or backup files, and so on.

• If [GSXD Test] command is executed on the system that does not use GSXD chipset, the 
result of [GSXD Test] shows a message that indicates this condition.

• To log-on to the SBX IP 320 system again after log-out from the SBX IP 320, click the 
[Enter] button in the [Input Box Bar].

• When this program is executed, some components of this program (i.e. buttons in 
[Command Bar]) may be hidden. In this case, enlarge or maximize the window, then you 
will see all the components of this program.

• The title of a button in the [Command Bar] may be aligned into two lines if the length of 
the title is long.
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Full Screen Layout

[File] Menu

[File] menu includes [Open], [Save], [Save As], [Print], [Print Preview], [Print Setup], and 
[Recent Files] that are file related operations.
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[Open] Sub-menu

1. Select [Open] sub-menu in [File] menu.  =>  [Open Dialog] appears.

Or you can use the tool button  in the [Toolbar] to execute the same command. 

2. Select one of the saved files (file extension is *.dat).

3. Click the [OK] button.

The dialog is closed, and the contents of the file is displayed in the [Data Display Area].

[Capture On] Sub-menu

1. Select the [Capture On] sub-menu in the [File] menu. =>  [Save As Dialog]appears.

2. Enter different file name.

3. Click [OK] button.

[Capture Off] Sub-menu

Select [Capture Off] sub-menu in [File] menu.
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[Connection] Menu

The SBX IP 320 system and this program can be connected in three ways, Serial, Modem, or 
LAN.

Serial Port Connection with SBX IP 320 System

For the serial port connection between the PC and the SBX IP 320 system, there must be a 
physical connection with RS-232C standard serial cable.

• The pins used in connection cable should be connected as follows;

[Transmit] : [Transmit] of SBX IP 320 and [Transmit] of PC must be connected.

[Receive] : [Receive] of SBX IP 320 and [Receive] of PC must be connected.

[Ground] : [Ground] of SBX IP 320 and [Ground] of PC must be connected.

• The length of connection cable depends on the communication environment of the 
system. In normal conditions, the cable length is limited to 15 meters. In better 
conditions, a 30-meter cable can be used.

• If the SBX IP 320 system is connected to the serial port on the MPB, select one of the 
transmission rates - 2400bps, 4800bps, or 9600bps.
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[Serial Port Configure] Sub-menu

[Serial Port Configure] is for configuring the serial port of the PC that is to be connected to the 
SBX IP 320 system.

• When the serial port connection is established, you cannot select this menu. The menu 
item is disabled in this case.

• Setting values are stored for the next session, at which time they are automatically 
restored and used.

Procedure:

1. Select [Serial Port Configure] sub-menu in the [Connection] menu. The [Serial Port 
Configuration Dialog] appears.

2. Enter setting values.

[Port] : Select connection port to be connected to the SBX IP 320.

[Baud Rate] : Select one of 2400bps, 4800bps, 9600bps. Selected [Baud Rate] must be 
same as that of the SBX IP 320.
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[Parity] : Select [None].

[Data Bits] : Select [8].

[Stop Bits] : Select [1].

[Flow] : All of [DTR/DSR], [RTS/CTS], [XON/XOFF] are not to be checked.

3. Click the [OK] button.

[Serial Port Connect] Sub-menu

[Serial Port Connect] connects the serial port of the PC and the SBX IP 320 system with the 
setting values from [Serial Port Configure].

If the connection fails, an error message shows to indicate that another program is using the 
serial port or the port does not exist.

If the connection is established successfully, a message box appears to notify you of this. The 
success of connection means that the connection between this program and the serial port of the 
PC is successfully established. This does not mean the connection between this program and the 
SBX IP 320 system is successfully established.

If the serial port is already connected, the sub-menu and the tool button for serial port 
connection cannot be selected.
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Procedures:

1. Select [Connection] menu.

2. Select [Serial Port Connect] in [Connection] menu.

-or-

Use the tool button in the [Toolbar] to execute the same command.

[Serial Port Disconnect] Sub-menu

[Serial Port Disconnect] disconnects the serial port connection between the PC and the SBX IP 
320.

Conditions:

• If the two serial ports are already disconnected, the menu and the toolbar for serial port 
disconnection cannot be selected.

Procedures: 

1. Select the [Connection] menu.

2. Select the [Serial Port Disconnect] sub-menu in the [Connection] menu.

-or-

Use the tool button  in the [Toolbar] to execute the same command.

Modem Connection with the SBX IP 320 System

For the modem connection between the PC and the SBX IP 320 system, an internal or external 
modem is needed for the PC. Before executing this program, a modem should be installed in the 
PC. Modem installation does not merely mean the physical connection between PC and modem, 
but it includes all the procedures needed, such as installing a device driver file for 
MS-Windows.

[Modem Configure] Sub-menu

[Modem Configure] is for configuring the PC modem that is to be connected to the SBX IP 
320system.

Conditions:

• When the modem connection is established, you cannot select this menu. The menu item 
is disabled in this case.

• The MODU must be installed on the MPB of the SBX IP 320 system.
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• By clicking the [Configure] button in [Modem Configuration Dialog], you can select or 
change various settings for the modem configuration. The setting values are effective 
only during the execution time of this program and are not stored for the next execution. 
Those values do not affect the modem settings of MS-Windows itself. To change modem 
configuration, use the [Control Panel] of MS-Windows. The changed settings from the 
[Control Panel] are applied to all application programs using the modem.

Procedure:

1. If needed, select or change modem settings by using [Control Panel].

2. Select the [Modem Configure] sub-menu in the [Connection] menu. The [Modem 
Configuration Dialog] appears and the dialog shows the current settings.

• [Select Active Device]: Select a modem that is to be used for modem connection 
with the SBX IP 320 system. The setting value is stored, and is restored and used 
when this program is executed the next time.

• [Configure] button: This is for setting detailed modem configurations. The setting 
values are effective only during the execution time of this program and are not 
stored for next execution. Those values do not affect the modem settings of 
MS-Windows itself.

3. Click the [OK] button.
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[Modem Connect] Sub-menu

[Modem Connect] establishes modem connection with the setting values from [Modem 
Configuration].

Conditions:

• If a connection failure occurs, an error message is shown. The reason for the failure may 
be improper installation of the modem, turning-off state of the modem, busy state of the 
destination, or various telecommunication problems that may occur during the session. 

• If an unavailable phone number is entered or the full phone number is not entered or the 
destination does not answer, the connection is disconnected after a period of time that 
was set from [Modem Configure] as a time-out value.

• When making a modem connection, a [Call Status Dialog] window that shows the status 
of the modem call appears. This program shows call status messages sent from the 
modem or modem device driver. Therefore, the messages in the [Call Status Dialog] 
window may differ from modem to modem. The [Call Status Dialog] window can be 
hidden from the screen by clicking the [Hide] button on the right of the [Call Status 
Dialog] window. 

• When the modem connection is established, you cannot select this menu. The menu item 
is disabled in that case.

Procedure:

1. Select the [Modem Connect] sub-menu in the [Connection] menu.  =>  [Phone Number 
Dialog] appears.

-or-

Use the icon  in the toolbar to execute the same command.
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2. Enter a phone number and make a modem call to a destination by using [Phone Number 
Dialog] (refer to the description below for detailed explanation about how to use [Phone 
Number Dialog]).

3. If a connection failure occurs, an error message is shown, and if the connection is 
established, a message box shows up to notify of this.

[Phone Book]

The [Phone Book] is used for entering / storing phone numbers and making a modem call to a 
destination.

Procedure:

To open the [Phone Book], click the [Modem Connect] sub-menu.

To close the [Phone Book], click the [Quit] button.
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To enter a new phone number:

1. Click the [New] button to enter a new phone number  =>  [Edit Phone Number Dialog] 
appears.

2. Enter the [Name] and [Phone Number]. The [Name] and [Phone Number] can be up to 40 
characters, respectively. Five special characters cannot be entered for the [Name]. These 
characters are the left and right brackets (parens), the left and right braces, and the 
semicolon. For [Phone Number], only [Dialable Characters] can be input (refer to the 
description below for detailed explanation about [Dialable Characters]).

3. A newly entered phone number is shown in the [Phone Number Dialog] if the [OK] 
button is clicked. Click the [Cancel] button to cancel the input.

4. If you want to save the new phone numbers into a [PhoneNo.txt] file for future use, click 
the [Save] button in the [Phone Number Dialog]. If you close the [Phone Number Dialog] 
window without clicking the [Save] button, the newly entered phone number will be lost.

To modify an existing phone number:

1. In the [Phone Number List Box], select a phone number item to be modified by clicking 
the [Name] of the item.

2. After a selection is made, click the [Modify] button.  => the [Edit Phone Number Dialog] 
appears.
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3. Modify the [Name] and/or [Phone Number]. The [Name] and [Phone Number] can be up 
to 40 characters, respectively. Five special characters cannot be entered for the [Name]. 
These characters are the left and right brackets (parens), the left and right braces, and the 
semicolon. For the [Phone Number], only [Disabled Characters] can be input (refer to the 
description below for detailed explanation about [Disabled Characters]).

4. A modified phone number is shown in the [Phone Number Dialog] if the [OK] button is 
clicked. Click the [Cancel] button to cancel the input.

5. If you want to save the modified phone number into a [PhoneNo.txt] file for future use, 
click the [Save] button in the [Phone Number Dialog] window. If you close the [Phone 
Number Dialog] window without clicking the [Save] button, the modification will be 
lost.

To delete an existing phone number:

1. In the [Phone Number List Box], select a phone number item to be deleted by clicking the 
[Name] of the item.

2. After a selection is made, click the [Delete] button. => a [Delete Confirmation Message 
Box] appears.

3. A deleted phone number is eliminated from the [Phone Number Dialog] if the [OK] 
button is clicked. Click the [Cancel] button to cancel the deletion.

4. If you want to remove the deleted phone number from the [PhoneNo.txt] file, click the 
[Save] button in the [Phone Number Dialog]. If you close the [Phone Number Dialog] 
window without clicking the [Save] button, the deletion will not be made in the file.

To store the contents of the [Phone Number List Box] into a file:

1. Click the [Save] button in the [Phone Number Dialog].

2. A message box indicating success or failure of [Save] operation shows up.

• The contents of the [Phone Number List Box] are saved in a [PhoneNo.txt] file that is 
located in the directory where this program is installed. You must not edit this file, and if 
you delete this file by mistake, all the data in the file will be lost.

• For the stable use of the [Phone Number Dialog], it is recommended to keep less than 
1000 phone numbers. However, this program does not check and limit the number of 
phone numbers.
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To make a modem call using the [Phone Number List]:

1. In the [Phone Number List Box], select a phone number item to be called by clicking the 
[Name] of the item.

2. Click the [Call] button in the [Phone Number Dialog] => A [Call Information Message 
Box] appears.

3. If the [OK] button is clicked, the modem call is started. Click the [Cancel] button to 
cancel the modem call.

-or-

1. Double-click on an item in the [Phone Number List Box] => A [Call Information 
Message Box] appears.

2. If the [OK] button is clicked, the modem call is started. Click the [Cancel] button to 
cancel the modem call.

To make a modem call with the [Speed Call] button:

1. Click the [Speed Call] button in the [Phone Number Dialog] => A [Speed Call Dialog] 
appears.

2. Enter the phone number in the [Phone Number] field. Only [Disabled Characters] can be 
input into the [Phone Number] field (refer to the description below for detailed 
explanation about [Disabled Characters]).

3. Click the [OK] button, then the [Call Information Message Box] appears. If the [OK] 
button is clicked on [Call Information Message Box], the modem call is started. Click the 
[Cancel] button to cancel the modem call. If the [Cancel] button is clicked in [Speed Call 
Dialog], the modem call is canceled.
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[Disabled Characters]

[Disabled Characters] are used to form a phone number that can be dialed. This program 
supports generally used [Disabled Characters]. Part of the [Disabled Characters] may not work 
properly for some telephone networks or modems.

• 0 - 9  A - D  *  #

DTMF and/or pulse digits.

• !

Hookflash (one-half second on hook, followed by one-half second off hook before 
continuing).

• P  p

Pulse dialing is to be used for the digits following this.

• T  t

Tone (DTMF) dialing is to be used for the digits following this.

• ,

This indicates that dialing is to be paused. The duration of a pause is device specific. 
Multiple commas can be used to provide longer pauses.

• W  w

This indicates that dialing should proceed only after a dial tone has been detected.

• $

This indicates that dialing the billing information is to wait for a "billing signal" (such as 
a credit card prompt tone).
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[Modem Disconnect] Sub-menu

[Modem Disconnect] disconnects the modem connection.

Conditions:

• When the modem connection is disconnected, you cannot select this menu. The menu 
item is disabled in that case.

Procedures:

1. Select the [Connection] menu.

2. Select the [Modem Disconnect] sub-menu in the [Connection] menu.

-or-

Use the icon in the [Toolbar] to execute the same command.

If a disconnection failure occurs, an error message is shown, and if the connection is 
disconnected, a message box is shown.

Important Note for Users

The success of serial port connection means that the connection between this program and the 
serial port of the PC succeeded. This does not mean the connection between this program and 
the SBX IP 320 system succeeded.

Even though a serial port or modem connection is disconnected by accident or some other 
reason, the program does not detect this. Instead, the program shows a message box if there is 
no answer after sending a command to the SBX IP 320 system.

If a modem connection is not established after a period of time that was set in [Modem 
Configure] as a time-out value, the program gives up making a modem connection and shows a 
message box to notify of this.
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LAN Connection with the SBX IP 320 System

For the LAN connection between PC and the SBX IP 320 system, there must be a physical 
connection with 10BaseT cable to the local network.

Conditions:

• The SBX IP 320 system and PC must have valid IP addresses.

• If you want to connect directly, you have to use cross UTP cable. That means that the 
[Transmit] and [Receive] are crossed. But you connect the SBX IP 320 system and PC 
with a Hub, and you can use normal UTP cable that is used in your local network.

• If you want to connect from a different segment of the LAN or from an external site (via 
Internet), the SBX IP 320 system must have a correct gateway address (default router). If 
it does not have a gateway address, remote connection using TCP/IP is not possible.

• If you want to connect the SBX IP 320 system that is used in a remote site, you may need 
help from the network administrator, because many sites use a firewall/NAT/PAT in their 
router.

• In a remote connection using Internet, connection speed/stability is dependent on the 
environment of WAN traffic or routing.
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[LAN Configure] Sub-menu

[LAN Configure] is for configuring the destination IP address that is to be connected to the SBX 
IP 320 system.

• Conditions:

• When the LAN connection is established, user cannot select this menu. The menu item is 
disabled in that case.

• Setting values are stored for the next session at which they are automatically restored and 
used. But only one IP address will be saved.

Procedures:

1. Select the [LAN Configure] sub-menu in the [Connection] menu. The [LAN 
Configuration Dialog] appears.

2. Enter the destination IP address.

3. Click the [OK] button.

[LAN Connect] Sub-menu

[LAN Connect] connects the PC and SBX IP 320 system with the IP address setting from [LAN 
Configure].

Conditions:

• If the connection fails, an error message appears. It means that the IP address is not valid 
or the SBX IP 320 system does not have an IP address or there are some errors.

• If the connection is established successfully, a message will display in the [Display Area]. 
The success of connection means that the connection between this program and the NIC 
of the PC succeeded. This does not mean the connection between this program and the 
SBX IP 320 system succeeded.
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• If the LAN port is already connected, the sub-menu and the tool button for LAN 
connection cannot be selected.

Procedures:

1. Select the [Connection] menu.

2. Select [LAN Connect] in the [Connection] menu.

-or-

Use the icon in the toolbar to execute the same command.

LAN Disconnect] Sub-menu

[LAN Disconnect] disconnects the LAN connection between PC and SBX IP 320.

Conditions:

• If the LAN connection is already disconnected, the menu and the toolbar for LAN 
disconnection cannot be selected.
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Procedure: 

1. Select the [Connection] menu.

2. Select the [LAN Disconnect] sub-menu in the [Connection] menu.

-or- 

Use the icon in the toolbar to execute the same command.

[Commands] Menu

This program can send commands to the SBX IP 320 system to get diagnostic results while a 
connection is established. This program reads command configuration from the [CmdConf.txt] 
file that is installed with the executable file, and uses the data for [Menu], [Command Bar], and 
[Input Box Bar]. The [CmdConf.txt] file is a command configuration file, and the contents of 
the file follow special rules for command configuration.
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Executing Commands

The following is a description of how to execute commands.

* This program does not check the validity of the command argument that is needed for some 
commands, and error handling is done in the SBX IP 320 system.

Using [Commands] Menu

The [Commands] menu includes all the commands from the [CmdConf.txt] file.

Procedures:

1. Select the [Commands] menu => Sub-menu of [Commands] menu is shown.

2. Click on the sub-menu of the command to be executed.

3. If the command needs an argument, [Enter Command Argument Dialog] shows up. Enter 
a proper argument in it. The length of the argument is limited to 6 characters. The 
command is executed.

Using [Command Bar]

Procedures for Executing [Commands]:

1. Click the button of the command to be executed in the [Command Bar].

2. If the command needs an argument, [Enter Command Argument Dialog] shows up, and 
you can enter the proper argument in it. The length of an argument is limited to 6 
characters. The command is executed.
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Using [Input Box Bar]

The [Input Box Bar] can be used to execute almost all the monitoring and diagnostic commands 
supported by the SBX IP 320 system. Command usages and limitations follow the SBX IP 320 
system specification. The length of input in [SBX IP 320 Command Edit Box] is limited to 40 
characters

The [Input Box Bar] can be docked on the top or bottom side of the window.

Procedures for Using [SBX IP 320 Command Edit Box] and [Enter] Button

1. Click on [SBX IP 320 Command Edit Box] so that the input cursor is blinking inside the 
box. If the input cursor already exists in [SBX IP 320 Command Edit Box], this 
procedure is not needed.

2. Input the SBX IP 320 command in the [SBX IP 320 Command Edit Box]. The length of 
the input is limited to 40 characters.

3. Click the [Enter] button to send the command input in [SBX IP 320 Command Edit Box] 
to the SBX IP 320 system. Or, you can press the [Enter Key] on the keyboard to send the 
command.

• If the [Enter] button is clicked when [SBX IP 320 Command Edit Box] is empty, a 
character that corresponds to the [Enter Key] is sent to the SBX IP 320 system. 
The same operation can be done by pressing the [Enter Key] when the input 
cursor exists in [SBX IP 320 Command Edit Box].

• If you want to log-in again to the SBX IP 320 system after log-out from 
maintenance or monitor mode, you can click the [Enter] button to get a chance to 
input password and log-in again.

• When you try to execute a remote command (r-type command) that needs an 
argument by typing the command in [SBX IP 320 Command Edit Box], you 
should also type the argument with the command. For [SBX IP 320 Command 
Edit Box], [Enter Command Argument Dialog] is not provided.
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Functions of Commands

Commands provided by the SBX IP 320 system are:

[Monitor Commands] are available when you log on with "jennie" as the password.

? - Help menu

t b xx - Set Board Trace

t [c|e|h|t] ([s|c|d|t|v|#]xxx) [a|r] - Set Device Trace

t d - Delete Trace Info

t p - Show Trace Setup Info

d [addr1] [addr2] - Dump Memory

m addr xx - Modify Memory

s ### - STA Status

c ### - COL Status

v ### - VMIB Status

l ### - Logical STA Status

p [v][s] - Print Port Assign

gsxd dump [all] - GSXD dump

x - Exit monitor
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[Remote Commands] are available when you log on with "brandy" as the password.

? - Help Menu

bc - Display Board Configuration Table

bl - B-channel Listening

bs ## - View Board Status

db[de][dr] - Display Diagnostic Result

hd - Display HDLC Status

log [view|clear] - Log view or clear

reboot - Remote System Reset

setsw [oos|nor] ## - Set Service Switch

ta [all][period][atd][callsum]……- Traffic Analysis

ts - Display Time-slot Assigment

up - S/W Upgrade

vc [s][u][a]… - VMIB Annc/Usr Greeting Clear

ws ? - WTIB Statistics

x - Exit Command
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The [db] command's detail information is displayed below. 

db cc  - Configuration Constraint

db pf - Pre-Programmed Fault                                                                                                              

db ts  - Time-Slot Conflict

db ht - Hiway TestPre-Programmed Fault

db dt  - DTRU Test

db ct - CPTU Test

db mt  - Memory Test

db rt - RTC Test

db pc  - Power Capacity

db rc - RGU Capacity

de hs - HDLC Status

dr [is/ic] - ISDN Line Status

dr [ri/rc] - Reset Information

dr li [d/c/v/a] - Resource Assignment

Monitor - Set Board Trace

Sets trace for board in slot xx.

For setting trace for board in slot 7:

     mon>t  b  07

Monitor - Delete Trace Info

Deletes all current trace commands and revert to idle condition.
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Monitor - Set Device Trace

Sets trace for device. 

Command options are as follows:

c : device COMMAND tracing. (MP   PP)

e : EVENT tracing. (PP, Internal, Timer Event)

h : HIGHWAY tracing.

t : CTI device command / event tracing.

Device options are as following:

S : Tracing related to station

C : Tracing related to CO

D : Tracing related to DTMF

T : Tracing related to CPTU

V : Tracing related to VMIB channel

If you want to trace the Station 102 about Cmd, Evt and Hiway information, you should enter 
the command option with physical station number as following;

mon>t  ceh  s002

At the Sxxx, xxx should be physical station number, i.e., port number of station. So, even if the 
station number was changed from 102 to 702, the physical station number is not changed;

mon>t  ceh  s002

Monitor - Dump Memory

This command dumps memory between the two addresses, which are in hexa decimal format. 
If you omit one of the two address ranges, memories are dumped beginning at the address 
specified until pressing Ctrl+C.

Monitor - Modify Memory

This command modifies memory beginning at the address until pressing Ctrl+C.
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Monitor - COL Status

This command is used to show the status of a CO line connected to the SBX IP 320 system.

Conditions:

• This command can be executed when this program is connected to the SBX IP 320 
system.

• If the [OK] button is clicked without entering a value in the [Enter Command Argument 
Dialog], a message box displays to indicate "Empty field is not allowed".

• You can cancel the command by clicking the [X] button on the top right side of the [Enter 
Command Argument Dialog].

• The length of the argument is limited to 6 characters.

• The argument is a physical port number that starts from 1.

• If a non-numeric value is entered, the SBX IP 320 system assumes it as the starting port 
number.

• If an invalid value (or big value) is entered, the SBX IP 320 system handles the error.

Procedure: 

Select [CO Status] sub-menu in [Commands] menu, or click [CO Status] [Command Bar] 
button.

-or-

Input "c #" (# : Port Number) in the [SBX IP 320 Command Edit Box] and then click the 
[Enter] button, or select [CO Status] in [Remote Command Combo Box] and then click 
the [Execute] button.
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To show the status of CO number 07:

mon> c  07

This is an example of CO line status:

Monitor - STA Status

This command is used to show the status of a station connected to the SBX IP 320 system.

Conditions:

• This command can be executed when this program is connected to the SBX IP 320 
system.

• If the [OK] button is clicked without entering a value in the [Enter Command Argument 
Dialog], a message box displays to indicate "Empty field is not allowed".

• You can cancel the command by clicking the [X] button on the top right side of the [Enter 
Command Argument Dialog].

• The length of the argument is limited to 6 characters.

• The argument is a physical port number that starts from 0.

Slot0 ,  Chan0,  State0,  AscD255T255

 S lot  =  00,  Dev No = 00,  Hiway = 00,  T imeslot  =  2341cc
 RX_Sum Loc = f f f f,  T X_Sum Loc f f f f
Ucd0,  Store0,  S ent0

22739c 00 00 00 f f  00  00 00 f f  f f  f f  05  f f  f f  f f  01  00
2273ac 00 f f  f f  f f  f f  00  f f  00  00 00 00 00 00 00 00 00
2273bc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
2273cc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
2273dc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
2273ec 80 00 00 10 f f  f f  00  00 00 00 00 00 00 00 00 00
2273fc  00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
22740c 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
22741c 00 00 00 00 07 00 00 00 00 00 00 00 00 00 00 00
22742c 00 00 f f  00  00 f f  00 f f  00  f f  64  f f  00 00 00 f f
22743c f f  00 00 00 00 f f  f f  00  00 00 00 00 00 00 00 00
22744c 00 00 00 00 00 00 f f  f f  f f  00  f f  00  f f  f f  00  f f
22745c 00 00 00 f f  f f  00  f f  f f  f f  f f  f f  00  00 00
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• If a non-numeric value is entered, the SBX IP 320system assumes it as the starting port 
number.

• If an invalid value (or big value) is entered, the SBX IP 320 system handles the error.

Procedure:

Select [Station Status] sub-menu in [Commands] menu, or click [Station Status] 
[Command Bar] button.

-or-

Input "s #" (# : Port Number) in the [SBX IP 320 Command Edit Box] and then click the 
[Enter] button, or select [Station Status] in the [Remote Command Combo Box] and then 
click the [Execute] button.

To show the status of station 107:

mon> s 008

This is an example of STA status:

Slot1 ,  Chan97,  State1,  AscD255T255
Ucd0,  Store0,  S ent0
Xfer0 ,  Hold0,  He ld255

22175c 00 01 01 04 00 61 01 f f  f f  f f  f f  f f  f f  00  f f  f f
22176c f f  f f  f f  40  00 00 80 00 60 18 00 00 00 f f  f f  00
22177c 00 00 00 00 00 f f  f f  f f  f f  00  0a  08 00 f f  00  00
22178c f f  f f  00  00 f f  00  00 00 00 00 00 00 f f  f f  f f  f f
22179c f f  f f  f f  00  f f  00  00 00 00 00 00 00 00 00 00 00
2217ac 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
2217bc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
2217cc 00 00 00 00 00 00 00 f f  f f  f f  f f  f f  f f  f f  f f  f f
2217dc f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f
2217ec f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f
2217fc  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f
22180c f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f
22181c f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f
22182c f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  f f  00  00 13 39 2e
22183c 00 2a  05 00 f f  00  00 00 00 00 00 14 00 01 00 00
22184c 00 00 00 00 00 00 00 00 00 01 00 00 00 00 00 00
22185c 00 00 00 f f  00  18 00 00 00 00 f f  f f  f f  f f  01  b8
22186c 00 00 f f  f f  00 00 00 00 00 22 18 74 00 22 18 74
22187c 00 22 18 7c  00 22 18 7c  00 00 00 00 f f  00  f f  f f
22188c 00 00 00 f f  84  f f  f f  f f  f f  02  84 f f  f f  f f  f f  02
22189c f f  f f  00  00 00 f f  f f  00
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Monitor - Print Channel Assign

This command sets the print port. You can select one of several print ports. By default, serial 
interface unit 1 is used.

Monitor - x

This command is used to log-out from the SBX IP 320 system.

Conditions:

• This command can be executed when this program is connected to the SBX IP 320 
system.

Procedure: 

Select the [Log Out] sub-menu in the [Commands] menu, or click the [Log Out] 
[Command Bar] button.

-or-

Input "x" in the [SBX IP 320 Command Edit Box] and then click the [Enter] button, or 
select [Log Out] in the [Remote Command Combo Box] and then click the [Execute] 
button.

Monitor - ?

This command is used to show the help messages of [Remote Commands].

Conditions:

This command can be executed when this program is connected to the SBX IP 320 system.

Procedure: 

Select the [Help Message] sub-menu in the [Commands] menu, or click the [Help 
Message] [Command Bar] button.

-or-

Input "?" in the [SBX IP 320 Command Edit Box] and then click the [Enter] button, or 
select the [Help Message] in the [Remote Command Combo Box] and then click the 
[Execute] button.
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Maintenance - Display Board Configuration Table(bc)

This command is used to show the board configuration of the SBX IP 320 system.

Conditions:

This command can be executed when this program is connected to the SBX IP 320 system.

Procedure:

Select the [Board Configuration] sub-menu in the [Commands] menu, or click [Board 
Configuration] [Command Bar] button.

-or-

Input "bc" in the [SBX IP 320 Command Edit Box] and then click the [Enter] button, or 
select [Board Configuration] in the [Remote Command Combo Box] and then click the 
[Execute] button.

Maintenance - B-channel Listening(bl)

Listens B-channel of specified time slot.

Maintenance - View Board Status(bs ##)

This command shows board status. ## is slot number.

Maintenance - Display HDLC Status(hd)

This command shows HDLC status.

Maintenance - Log View or Clear(log [view|clear])

Log information can be viewed and cleared by this command.

Maintenance - Remote System Reset(reboot)

This command resets the system. You must enter the admin password twice to reset the system. 
If an admin password does not exist, 147* is used temporarily for the admin password.
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Maintenance - Traffic Analysis(ta [all][period][period_abort][atd][callsum] 
[callhour] [hw] [cosum] [cohour])

Shows traffic analysis data.

Command options are:

ta all <timetype> - Print All Traffic Report

ta period <hhmm> <timetype> - Print Traffic Report Periodically

ta period_abort - Cancel Periodic Print

ta atd <timetype> - Print Attendant Traffic Report

ta callsum - Print Call Summary Report

ta callhour - Print Call Hourly Report

ta hw  <timetype> - Print H/W Usage Summary Report

ta cosum  <timetype> - Print CO Traffic Summary Report

ta cohour <cogrp#> - Print CO Traffic Hourly Report

 timetype - [tt|yt|lh|yp|tp]

- tt : Today Total

- yt : Yesterday Total

- lh : Last Hour

- yp : Yesterday Peak

- tp : Today Peak

Maintenance - Display Time-slot Assignment(s)

Displays time-slot assignment.

Maintenance - S/W Upgrade(up)

Upgrades software.
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Maintenance - WTIB Statistics(ws ## [command])

Shows WTIB statistic data.

Command options are:

[?] : Help

[upload] : Upload Data statistics data

[call] : Total number of call & direction of the call

subs] : Information per subscripted device

[eoc] : End of call

[cell] : Usage of frequency and slot

[traf] : Show holding time

[acce] : Access info.(basic/hand-over)

[clea] : Clear statistics data

Maintenance - Exit(x)

This command is used to log-out of the SBX IP 320 system.

Conditions:

• This command can be executed when this program is connected to the SBX IP 320 
system.

Procedure: 

Select the [Log Out] sub-menu in the [Commands] menu, or click the [Log Out] 
[Command Bar] button.

-or-

Input "x" in the [LDK Command Edit Box] and then click the [Enter] button, or select 
[Log Out] in the [Remote Command Combo Box] and then click the [Execute] button.
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Maintenance - Help(?)

This command is used to show the help messages of [Remote Commands].

Conditions:

• This command can be executed when this program is connected to the SBX IP 320 
system.

Procedure:

Select the [Help Message] sub-menu in the [Commands] menu, or click the [Help 
Message] [Command Bar] button.

-or-

Input "?" in the [SBX IP 320 Command Edit Box] and then click the [Enter] button, or 
select [Help Message] in the [Remote Command Combo Box] and then click the 
[Execute] button.

Diagnostic - Configuration Constraint(db cc)

Shows if the current configuration meets the configuration constraints.

Diagnostic - Preprogrammed Fault(db pf)

Shows preprogrammed faults. Checks if the admin programmed data are different from the 
boards that are installed in the system. Prints a warning message if there is any difference.

Diagnostic - Time-slot Conflict(db ts [sl][cf])

Shows time-slot assignment table and time-slot assignment conflict status. In case of PRIB, 
channel 31, 32 should be assigned the same time slot with that of channel 1. Command options 
are:

[sl] - time-slot assignment table

[cf] - time-slot conflict

Diagnostic - Hiway Test(db ht ## ## #)

Tests PCM hiways using one DKT and one DTMF receiver. If you assign slot number, dtmf 
receiver duration time, and hiway number, this program tests 48 time-slots in the specified 
hiway. Note that the first DKT of the assigned slot is used for the test. The DKT is connected to 
time-slot successively and DTMF tone is connected to that time-slot too. If the DKT receives 
the specified DTMF tone, we consider the time-slot is operating correctly.

Usage: db ht xx yy # ( xx: slot number (DTIB), yy: dtmf duration time, #: hiway number(0-7))
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Diagnostic - DTRU Test(db dt)

Tests DTMF receiver. This feature tests all DTMF receivers in the system. Currently a max of 
32 dtmf receivers can be tested

Diagnostic - CPTU Test(db ct)

Tests CPTU.

Diagnostic - Memory Test(db mt)

Tests DRAM modules. Writes specified value (e.g. 0x5a) to the DRAM and reads again, to 
check if valid data are read.

Diagnostic - RTC Test(db rt)

Tests RTC. You can see the current time and modify it. The time does not elapse when you test 
RTC, so you have to correct the time before you finish.

Diagnostic - Power Capacity(db pc)

Shows power capacity of the PSU and current power usage status of the system. If the total 
power usage per rack exceeds the limit, you should change the configuration.

Diagnostic - RGU Capacity(db rc)

Shows RGU capacity. This feature shows RGU capacity, CO incoming ring cadence, and ICM 
call ring cadence. You don't have to uninstall the station even if the number of stations exceeds 
the RGU capacity.

Diagnostic - HDLC Status(de hs)

Shows HDLC status.

Diagnostic - Reset Information(dr ri)

Shows reset information.
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Diagnostic - Resource Assignment(dr li [d|c|v|a])

Shows current resource assignment

d - DTMF receiver assignment

c - CPTU assignment

v - VMIB channel assignment

a - DTMF, CPTU, VMIB channel assignment

[View] Menu

The [View] menu is used for showing / hiding the [Toolbar], [Status Bar], [Command Bar], 
[Input Box Bar], and for clearing [Data Display Area] and starting a new document.

[Toolbar] Sub-menu

The [Toolbar] sub-menu operates as a toggle. A check mark is shown when the toolbar is shown 
on the screen.
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Procedure:

Select the [Toolbar] sub-menu in the [View] Menu. If the [Toolbar] is shown on the 
screen, it becomes hidden. If it is hidden already, it becomes shown.

[Command Bar] Sub-menu

The [Command Bar] sub-menu operates as a toggle. A check mark is shown when the 
[Command Bar] is shown on the screen.

Procedure:

Select the [Command Bar] sub-menu in the [View] Menu. If the [Command Bar] is 
shown on the screen, it becomes hidden. If it is hidden already, it becomes shown.

** The Command Bar is enabled only after you have entered Monitor or Maintenance Mode.

[Input Box Bar] Sub-menu

The [Input Box Bar] sub-menu operates as a toggle. A check mark is shown when the [Input 
Box Bar] is shown on the screen.

Procedure:

Select [the Input Box Bar] sub-menu in the [View] Menu. If the [Input Box Bar] is shown 
on the screen, it becomes hidden. If it is hidden already, it becomes shown.

[Clear New] Sub-Menu

The [Clear New] sub-menu is used for clearing the [Data Display Area] and starting a new 
document. Because a new document has no name (or title) yet, "Untitle" is shown on the [Title 
Bar] of the window as a document name.

Procedure:

Select [Clear New] sub-menu in [View] Menu.

-or-

Use the icon in the toolbar to execute the same command.

All the data displayed in [Data Display Area] are erased and a new document is started.
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[Help] Menu

In the [Help] menu, only [About SBX Remote Diagnostic Tool] sub-menu exists.

[About SBX Remote Diagnostic Tool] Sub-menu

When the [About SBX Remote Diagnostic Tool] sub-menu is clicked, the [About SBX Remote 
Diagnostic Tool Dialog] displays, and the name of this program and copyright information is 
displayed on the dialog.

Procedure:

1. Select the [About SBX Remote Diagnostic Tool] sub-menu in the [Help] menu.

-or-

Use the icon in the toolbar to execute the same command. The [About SBX Remote 
Diagnostic Tool Dialog] displays.

2. Click the [OK] button and the [About SBX Remote Diagnostic Tool Dialog] disappears.
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[Data Display Area]

The [Data Display Area] displays the data from serial port, modem, or data file. When 
displaying data, this area follows certain rules and executes functions according to them.

Data Display Functions

If the data to be displayed exceeds the size of the [Data Display Area], a vertical scroll bar 
appears to enable scrolling in the [Data Display Area]. A horizontal scroll bar is always 
displayed even though the width of the displayed data does not exceed the size of the [Data 
Display Area].

• When data are coming from the serial port or modem, the [Data Display Area] is 
automatically scrolled to the last line if the data to be displayed exceeds the size of the 
[Data Display Area].

• If the data are from the data file, the [Data Display Area] is not scrolled to the last line, 
but displays the data from the first line.

• If a data file is opened while data are coming from the serial port or modem and being 
displayed in the [Data Display Area], previously displayed data are erased and new data 
from the data file are displayed in the [Data Display Area]. If more data are still coming 
from the serial port or modem, the data are appended after the last line of the file data and 
the file name remains the same. This is to prevent loss of real time data from the serial 
port or modem.

• If you execute an SBX command after opening a data file, the file is closed and a new file 
(or document) is started with the name "Untitled".

• Once a file name is assigned for the data in the [Data Display Area] by using the [Save] 
sub-menu or the [Save As] sub-menu, the file name remains the same even though more 
data are coming from the serial port or modem and being displayed. Therefore, the 
appended data can be stored in the same file.

• If the [Clear New] sub-menu is selected or the [Clear New] tool button is clicked, the 
[Data Display Area] is cleared and a new document (or file) named "Untitled" is started.
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Automatic Data Storing Functions

The [Data Display Area] does not scroll indefinitely. If the number of lines of displayed data 
exceeds 2,000 lines (approximately), this program stores the displayed data into a data file and 
clears the [Data Display Area]. Then, this program keeps displaying incoming data in the [Data 
Display Area]. The maximum number of lines of data is system-dependant. If the PC is using 
smaller fonts, more lines will be displayed.

• Generally, if more than 2,000 lines of data are displayed in the [Data Display Area], the 
data are automatically stored in a data file. The name of the file has the format of 
"Thhmmss.dat" (hh : current hour ,  mm : current minute ,  ss : current second), and this 
file is saved in the directory where this program is installed. You can open this file by 
using the [Open] sub-menu or the [Open] tool button to see the contents of the file.

• While the automatic data storing function is being executed, several bytes of data may be 
lost. This happens especially when the data transfer rate is high and performance of the 
PC is low or the PC is busy working other jobs. The first line of data displayed after 
automatic data storing function is executed may have a broken format.

Important Note for Users

If the performance of the PC is not good enough, some scrolled data may not have complete 
forms. If this happens, scroll in the [Data Display Area] by using the scroll bar to refresh the 
area.
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Chapter 10

Troubleshooting

PROBLEM CAUSE/SYMPTOM SOLUTION

SYSTEM POWER 
FAILURE

Power short circuit in some board(s) Exchange the malfunctioning board for 
one in good working condition.
Dust each board with a dry cloth.
Check the PSU fuse.
Replace the PSU with an identical  one.

LD1-4 LEDs on the MBU are All ON 
or All OFF

SYSTEM DOES 
NOT OPERATE

Power short circuit in some board(s) Check the connection of each board with 
the MBU.
Check the PSU.
Check for a short circuit on the MBU or 
other boards.
Press the Reset button when the DIP 
switch (SW1for database protection) is in 
the default position.

Bad board connection
System database not working

DKTU DOES NOT 
OPERATE

Bad extension circuit Exchange the malfunctioning board for 
one in good working condition.

Bad connection between the 
MBU/EMBU/CHB308 and DKT

Check the connection between the SLT 
line and DKT on MDF, and fix any 
mismatching.
Repair any broken connection between the 
System and DKT.

Proximity of DKT and System Check the distance between the
MBU/EMBU/CHB308 and the DKT

Bad DKT Plug the DKT into another extension port 
that has been verified as working. If the 
DKT still does not work properly, replace 
the DKT.

SLT DOES NOT 
OPERATE

Bad MBU/EMBU/CHB308 board Exchange the board for one in good 
working condition.

Bad connection between the 
MBU/EMBU/CHB308 and SLT

Check that the board connection between 
the lines of the SLT and DKT on the MDF, 
and fix any mismatching.

CO LINE 
OPERATION 

FAILURE

ANCR fail Check the U8 (Voice processing and Tone 
detection device).

Bad connection Check all connections.

EXPANSION KSU 
DOES NOT 
OPERATE

Power ON sequence Turn on the Basic KSU after turning on the 
Expansion KSU. Then press the Reset 
button.

Link cable connection Check the link cable to verify the 
connection and its working condition.
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NOISE ON 
EXTERNAL MOH 

AND PAGING 
PORT

Induced noise on the wire between 
the System and the amplifier

Make sure a shielded cable is in use as the 
connection wire between the system and 
the amplifier.

Excessive input level from the 
external music source

Decrease the output level of the external 
music source by using the volume control 
on the music source.

PROBLEM CAUSE/SYMPTOM SOLUTION
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